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Preface

This guide contains information about the following HIPS and
SIPS editors.  It describes the parts components and function of
each editor interface. 

The role of each of these editors in the HIPS and SIPS workflow
is described in the CARIS HIPS and SIPS Users Guide.

• “ATTITUDE EDITOR” ON PAGE 9
• “MOSAIC EDITOR” ON PAGE 19
• “PROCESS LIDAR DATA” ON PAGE 579
• “NAVIGATION EDITOR” ON PAGE 43
• “SIDE SCAN EDITOR” ON PAGE 49
• “PROCESS SINGLE BEAM DATA” ON PAGE 99
• “SUBSET EDITOR” ON PAGE 119
• “SVP EDITOR” ON PAGE 137
• “SWATH EDITOR” ON PAGE 149
• “TIDE EDITOR” ON PAGE 167
• “VESSEL EDITOR” ON PAGE 175

The HIPS and SIPS workflow, interface elements and tools are described 
in these documents: 
HIPS and SIPS User Guide
HIPS and SIPS Reference
HIPS and SIPS Tools



4



5

Table of Contents

1 Attitude Editor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Attitude Editor Interface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Display Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Colour Display  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Attitude Editor tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
All Views. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Scale . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Show . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Filter and Smooth . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

2 Mosaic Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Overview of Mosaic Editor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Open Mosaic Editor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Mosaic Editor toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Beam Pattern toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Mosaic Editor Control tabs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Properties of Mosaics and GeoBaRs . . . . . . . . . . . . . . . . . . . . . 24

Mosaic Layers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
GeoBaR layers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

3  Process LIDAR Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
LIDAR Data in HIPS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

LIDAR Projects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Data format. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
Display lidar data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

LIDAR tab. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Waveforms View  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Selecting Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Sounding Quality and Status Flags. . . . . . . . . . . . . . . . . . . . . . . 40

Selecting Detected and Alternative Data . . . . . . . . . . . . . . . . 40
Cleaning Sounding Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

4 Navigation Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
Navigation Editor Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
Navigation Editor tab. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

Number of points displayed . . . . . . . . . . . . . . . . . . . . . . . . . . 47



6

5 Side Scan Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Side Scan Editor workflow  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
Side Scan Editor Interface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Side Scan data display. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Side Scan Editor controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Colour Mapping  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
Navigate in Side Scan Editor . . . . . . . . . . . . . . . . . . . . . . . . . 60
Zoom  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
Selection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
Measure Distance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
Measure Shadow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Side Scan Editor and Swath Editor  . . . . . . . . . . . . . . . . . . . . 66

Signal Display Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Open Signal Display Window. . . . . . . . . . . . . . . . . . . . . . . . . 68
View Selection Mean . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
View Single Ping  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

Edit Side Scan Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Accept/Reject/Query  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Recompute Towfish Navigation . . . . . . . . . . . . . . . . . . . . . . . 73
Digitizing Sonar Altitude . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

Automatic digitizing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
Manual digitizing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
Interpolate Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

Image Processing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
Revert/Reapply. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

Slant Range Correction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
Apply Slant Range Correction  . . . . . . . . . . . . . . . . . . . . . . . . 81

Beam Pattern Correction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83
Create Beam Pattern Correction File  . . . . . . . . . . . . . . . . . . 83

Adjust Beam Pattern . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
Apply Beam Pattern Correction . . . . . . . . . . . . . . . . . . . . . . . 86

Angle-Varying Gain. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88
Time-Varying Gain  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
Despeckle . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
Contacts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93

Create Contacts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
Editing Contacts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
Recompute Contact Positions  . . . . . . . . . . . . . . . . . . . . . . . . 97

SIPS Template Wizard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98

6  Process Single Beam Data . . . . . . . . . . . . . . . . . . . . . . . 99
Single Beam Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
Single Beam Editor Interface  . . . . . . . . . . . . . . . . . . . . . . . . . . 101
Single Beam Editor tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

General tab. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
Events tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
Barcheck tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
Trace tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108



7

Primary and Secondary Data . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Change Sounding Depths. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110

Change Depths  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110
Add Depths. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111

Single Beam Cleaning  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
Reject Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
Accept Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
Query Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
Auto-Cursor Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

Single Beam Filtering . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114
Moving Average Filter . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
Depth  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
Beam-to-Beam Slopes . . . . . . . . . . . . . . . . . . . . . . . . . . 116
Apply Filters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

7 Subset Editor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120
Subset Editor Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121

Open Subset Editor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121
Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
Size and Resize Subset . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123

Subset Editor Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
View Subset Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
Colour Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127
Subset 2D View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
Subset 3D View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132

3-D Subset Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132
Controls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

Measure Distance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135
Close Subset Editor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136

8 SVP Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
SVP Editor Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138

Open an Existing File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141
SVP Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143
Create a New SVP File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144

Create New Profile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144
Enter new depth/speed data . . . . . . . . . . . . . . . . . . . . . . 145

Edit SVP Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146
Exit SVP editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 147

9 Swath Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149
Swath Editor Interface. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 150

Swath Editor Controls. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 150
Swath Editor Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151



8

Viewing Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
deTrend . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
Plan View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
Rear View. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153
Side View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153
Profile View  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153
Amplitude View. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154
3D View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154
Data Display in Views. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154

Swath Editor Display Options . . . . . . . . . . . . . . . . . . . . . . . . . . 155
General tab. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155
Vertical Exaggeration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156
Specified Min-Max . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156
Middle mouse button  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156
View soundings as points or lines  . . . . . . . . . . . . . . . . . . . . 157
Profile spacing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157
Colour By Depth . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 158

Examining Swath Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159
Select Swath and Beam. . . . . . . . . . . . . . . . . . . . . . . . . . . . 160
Swath Coverage Outline  . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
Changing Track Lines  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161

3D View Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 162
Compass  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163
Vertical Exaggeration Slider . . . . . . . . . . . . . . . . . . . . . . . . . 163
Light Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 164
Pan and Zoom . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 166
Close Swath Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 166

10  Tide Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167
Open Tide Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 168

Exit Tide Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
Editing Tide Data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171
Create a New Tide File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173
Display Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174

11 Vessel Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175
Vessel Editor Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 176

Open Vessel Editor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 176
HIPS Vessel File (HVF)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178

Open and Close Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178
Exit the Vessel Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 179

3D Display Controls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 180
Modify Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 181

Colour options for sensor display . . . . . . . . . . . . . . . . . . . . . . . 182



1
Attitude Editor

Attitude Editor displays sensor data related to the movement of a vessel 
or towed sensor. It also displays data from other auxiliary sensors that 
use a simple time/value data model. The data is plotted in chronological 
order and is time stamped. You can edit data directly in the editor or set 
filter parameters to reject unwanted data.

In this chapter...
ATTITUDE EDITOR INTERFACE......................................... 10
ATTITUDE EDITOR TAB .................................................. 14
DISPLAY OPTIONS ........................................................ 12
ALL VIEWS.................................................................. 15
DATA ......................................................................... 15
SHOW ........................................................................ 16
COLOUR DISPLAY......................................................... 12
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Attitude Editor: Attitude Editor Interface

Attitude Editor Interface
Attitude Editor is displayed in the HIPS and SIPS interface. To 
open the Editor:
1. Select a track line so it is highlighted.

2. Select the Attitude Editor command.

The Attitude Editor is displayed(as shown below). 

You can open the Attitude Editor while the Swath Editor is 
active and examine attitude and sounding data at the same time 
(see “SWATH EDITOR” ON PAGE 201).
The Project-Vessel-Day directory and file name of the selected 
track line is displayed on the title bar.
Data is graphed in the windows according to an X-Y axis. In the 
default layout, the X-axis represents time and the Y-axis 
represents data.
By default, the following data is displayed in the editor:
• Gyro: Gyro observations are displayed in degrees from 

positive 1 to 360.
• Heave: Heave observations are displayed according to the 

Units setting in the Options dialog box and are positive as the 
vessel moves upward.

M
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Attitude Editor: Attitude Editor Interface

• Pitch: Pitch observations are displayed in degrees and are 
positive when the bow is down.

• Roll: Roll observations are displayed in degrees and are 
positive when the starboard side is up.

However, this is not the only data that can be displayed in the 
editor. All sensor data in HIPS/SIPS format can be displayed 
except for depths, navigation, and side scan data.
Besides the above sensors, the following sensors can be 
displayed (if available):
• loaded tide
• side scan gyro
• side scan cable out
• side scan depth
• side scan height
• delta draft
• GPS height
• GPS tide
• speed on water
Applanix’s MS POV systems calculate TrueHeave values from 
real-time heave values. The computed TrueHeave data and real-
time heave values are stored in a binary file that is not 
converted to HIPS/SIPS format when other data is imported. 
These files have to be separately loaded to the track line. 
.
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Display Options
Show/hide sensor data You can control which attitude sensors windows are displayed in 

Attitude Editor. By default Gyro, Heave, Pitch and Roll sensor 
windows are opened. However, if the survey data does not 
contain data from one of these sensors, that sensor will not be 
displayed. (It can be turned on with the Sensor Layout 
command.)
1. Select the Sensor Layout command.

The Sensor Layout dialog box is displayed.

2. To remove a sensor from the Active Sensors list, select the sensor and 
click Remove.

3. To add a sensor to the Active Sensors list, select a sensor from the 
Available Sensors list and click Add.

4. Set the order that sensor windows are displayed by selecting a sensor 
and clicking the up or down arrow buttons, or by selecting the sensor 
and dragging it to a new position.

5. Click OK to apply settings.

The Active sensors are displayed in Attitude Editor according to 
the selected settings.

Colour Display
The colour for displaying the various graph lines can be changed.
1. Select the Options command.

The Options dialog box is displayed.

M
en

u Tools > Sensor 
Layout

M
en

u

Tools > Options
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2. Click the Display tab and click the Sensor Editors category so it is 
highlighted.

3. Select a colour for the sensor filter line from the drop-down colour 
palette, or create a custom colour from the standard Windows colour 
picker.

4. Click OK.

See “DISPLAY” ON PAGE 80 for more information on colour options for 
the Attitude Editor.
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Attitude Editor tab
The Attitude Editor tab is visible in the Control Window when 
Attitude Editor is opened.
 

The tab contains settings for three types of functions: 
“ALL VIEWS” ON PAGE 15

“DATA” ON PAGE 15

“FILTER AND SMOOTH” ON PAGE 16
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All Views
By default, time is displayed on the X-axis. As the time scale is 
increased, more data is displayed in the graphs. As the time is 
decreased, less data is displayed.
5. Click the up or down arrows beside the Time Period box to set time in 

minutes and/or seconds.

The Vertical option switches the data graph windows from a 
horizontal layout to a vertical layout. In this mode, the X-axis 
represents the data values and the Y-axis represents time.
6. To view the Attitude Editor in vertical mode, click the Vertical check box.

7. Select the Time Stamp check box to display the time stamp in the 
windows.

8. Click the Time Interval up or down arrow buttons to select an interval for 
time stamp display.

The display in all graphs is adjusted to the new time setting.

Data
The Data fields control the graphs of the raw sensor data in the 
Attitude Editor window. Highlight the type of data: Gyro, Heave, 
Pitch or Roll, from the list and then apply a Scale and / or Show 
option. 

Scale
By default, the data scale is shown on the Y-axis. The scale of 
the data axis can be based on the minimum and maximum 
values of data in the entire line, the minimum and maximum 
values of the data currently in view, or by a user-defined axis.
1. Select a sensor from the Data list.

2. Select from one of three scaling options:
• Select Max-Min of Line to scale data according to the minimum and 

maximum data values of the entire line.
• Select Max-Min of View to scale data according the minimum and 

maximum values currently in view.
• Select User-defined Max-Min to define maximum and minimum scale 

and type the values in the maximum and minimum fields.



16 CARIS HIPS and SIPS Editors 

Attitude Editor: Attitude Editor tab

Show
The Invert command displays the data in a “mirror-image” view. 
This function is useful for viewing towfish depth in the water 
column.
1. Select an attitude data type in the Data list.

2. Click the Data check box to display the graph of that type of data in the 
Altitude Editor. 

To invert the data in the graph, 
3. Select the Invert command.

The Draw Bars function displays vertical bars for each sensor 
value in the graphs. This option makes it easier to see time gaps 
between sensor values.
The following three options graph othre lines for comaprison to 
the data.
• Filter/Smooth Line graphs the computed values derived from 

the adjacent data points and displays this line in the graph.
• Difference graph a line showing the difference between the 

original data values and the moving average or FFT value for 
each data point.

• Thresholds display horizontal lines in the graph indicating 
the difference values that are clipped during smoothing. 
Threshold is a multiple of the standard deviation (sigma).
• The upper threshold signal is determined by the following 

formula: 
original mean value + (threshold value X the 
standard deviation)

• The lower threshold signal is determined by the following 
formula:
original mean value - (threshold value X the 
standard deviation

When you close the Attitude Editor, you are prompted to save 
any changes. This saves any smoothing changes to the 
SmoothedCoefficients file

Filter and Smooth
You can reject data with residual values that fall outside user-
defined threshold limits, and apply these changes to attitude 
data across entire track line(s), using the Filter andSmooth 
options.
(These options can also be applied from the Attitude filter. See 
“FILTER ATTITUDE DATA” ON PAGE 264 .)
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The Smooth Sensor function is used to smooth out localized 
variability. Any sensor data that can be viewed in the Attitude 
Editor can be smoothed.
In this example, GPS height and tide, are graphed. The blue line 
represents the original data and the yellow line represents the 
smoothed data. 

. The parameters for creating the smoothed data are saved to the 
SmoothedCoefficients file in the 
HCDS_Data\Project\Vessel\Day\Line folder. The file is in 
XML format. This file is applied to the track line during the 
merge process and SVP Correction.

Moving Average and 
Fast Fourier Transform

There are two methods available for smoothing: Moving Average 
and Fast Fourier Transform (or FFT). 
• The Moving Average function calculates an average sensor value 

over a window of data using the Box Size parameter. The 
window is defined as a number of data points or seconds 
centred on a point. The average value for all of the values in 
the window is calculated and will be given to the central 
point. 

• The Fast Fourier Transformation performs a low-pass filter on the 
selected sensor. You select a Box Size in either points or 
seconds. This value is converted into seconds and then 
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inverted to become the cut-off frequency. Increasing the Box 
Size results in greater smoothing.

Box size The Box Size (Step 6) determines how many neighbouring data 
points are used in the smoothing calculation. The number of 
neighbouring data points can determined using time or a set 
number of points.
The Moving Average and the Fast Fourier algorithm use the Box 
Size parameter in different ways. 
• The Moving Average function uses the Box Size to determine 

the window that is used to calculate the average for the new 
“smoothed” centre point. 

• The FFT algorithm uses the Box Size to define the cut-off 
frequency that is then applied to all data.

In the following example, the box size is set to five data points. A 
FFT value or mean for any data point is calculated from itself 
and ‘the two data points on either side of it (if available).

1. Make sure that the Control window is open and the Attitude Data tab is 
visible.

2. Select a sensor in the Data list box, or click inside a sensor window in 
the Attitude Editor.

3. Select the Smooth option.

4. Select either the Moving Average or Fast Fourier smoothing options.

5. Select either the Points or Seconds check boxes.

6. Click the Box Size up or down arrow buttons to select the number of 
adjacent data points or a time range.

7. Click Yes to save smoothed data.

Box Size = 5

FFT value or mean calculated for data point

Adjacent data points used for calculation of value
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Mosaic Editor

Mosaic Editor is used to create and edit mosaics, and to analyze the 
sediment properties of backscatter data through the created imagery. 

In this chapter...
OVERVIEW OF MOSAIC EDITOR....................................... 20
OPEN MOSAIC EDITOR ................................................. 21
MOSAIC EDITOR TOOLBAR ............................................. 21
BEAM PATTERN TOOLBAR .............................................. 21
MOSAIC EDITOR CONTROL TABS..................................... 23
PROPERTIES OF MOSAICS AND GEOBARS ....................... 24
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Mosaic Editor: Overview of Mosaic Editor

Overview of Mosaic Editor
In Mosaic Editor you can correct multibeam backscatter and 
sidescan sonar imagery. You can also create mosaics from 
imagery data. 

The full workflow for image processing in Mosaic Editor is 
described in PROCESS IMAGERY DATA in the Users Guide.

Overview of Mosaic Editor workflow 

Mosaics created as field sheet layers in HIPS and SIPS prior to 
version 7.0, can be opened in Mosaic Editor for comparison 
purposes, but they cannot be edited.
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Open Mosaic Editor
To open Mosaic Editor:
1. Select the Open Mosaic Editor command.

The Mosaic Editor and Beam Pattern toolbars are displayed. 
The Control Window is refreshed to display the three control 
tabs of Mosaic Editor. 

Mosaic Editor toolbar 
 

The Mosaic Editor toolbar contains the following controls:
• Create a GeoBaR: based on options selected in the Process 

tab.
• Create a Mosaic: from available GeoBaRs.
• Load a single GeoBaR for the selected trackline(s): you will be 

prompted to choose which GeoBaR(s) are loaded for each line.
• Load all GeoBaRs for the selected trackline(s)
• Unload all GeoBaRs for the selected trackline(s)
• Sediment Analysis Options: choose when to create a sediment 

analysis file for a line
• Open/Close Sediment Analysis Graph: display the graph or 

close an open graph.
• Auto Analyze: Apply sediment analysis to all selected lines 

for which GeoBaRs have been created. 

Beam Pattern toolbar 

The Beam Pattern toolbar has the following controls:
• Create Beam Pattern: create a Geocoder beam pattern file.
• Load Beam Pattern: open an existing Beam Pattern File for 

use during Beam Pattern Correction.

M
en

u Tools > Mosaic Editor 
> Open

To
ol

 

Create 

Open/Close Sediment
Analysis graph

GeoBaR
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Load single
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Unload GeoBaRs Sediment Analysis 
OptionsGeoBaR 

Reset Auto Histogram Histogram

Auto Analyze 
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• Close Beam Pattern: close an open Beam Pattern file.
• Save Beam Pattern: save an open Beam Pattern file.
• Save Beam Pattern As: save an open Beam Pattern file under 

another name or location.
• View Beam Pattern: open the Beam Pattern graph window to 

display the average beam pattern intensity as a function of 
angle from nadir. With the Geocoder processing engine 
backscatter dB (decibel) is displayed, and with SIPS engine, 
intensity values are displayed.

• Remove Spikes: removes anomalies from the Beam Pattern 
Graph (not available with the Geocoder processing engine).

• Smooth Beam Pattern: uses a moving average filter to reduce 
noise in the beam pattern (not available with the Geocoder 
processing engine).

• Reload: restore the beam pattern file to the point just after 
you last saved it. 

• Set Sediment Class: choose the sonar frequency (Hz) and 
mean grain size and set it for the selection (not available with 
the SIPS processing engine.)

• Set Beam Pattern Offset (dB) for the selection (not available 
with the SIPS processing engine).

Side Scan Editor If you wish to see a waterfall display at the same time as your 
georeferenced imagery, you can open Side Scan Editor as well as 
Mosaic Editor. 
1. Open Mosaic Editor. 

2. Select a single trackline and open Side Scan Editor.

The SIPS Preview window will open and display the waterfall 
view.

Create Beam 

Load Beam 

Close Beam 

Save Beam 

Save Beam 

View Beam 

Reload

Set Sediment 
Pattern

Pattern 

Pattern Pattern As

Pattern Pattern Class

Remove Spikes

Smooth Beam 
Pattern

Set Beam 
Pattern Offset 
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Mosaic Editor Control tabs 
The tabs are
• Process - used to set the options for the creation of GeoBaRs
• Analysis - used to perform sediment analysis on backscatter
• Edit - used to edit the display of mosaics or GeoBaRs “on-the-

fly” and change the draw order of the GeoBaRs
The image below displays the tabs in the Control window. 
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Properties of Mosaics and GeoBaRs
Mosaics and GeoBaRs created in Mosaic Editor are listed in the 
Layers tab together with their attribute layers. When a layer is 
selected its properties are displayed in the Properties window. 
These properties can be viewed, and some edited, when a layer is 
selected.
 

Mosaic Layers
Most of the information in the Properties for a Mosaic parent 
layer is read-only, however, these fields can be edited:
 

Properties Function

General 

Vertical Coordinate System Select the appropriate vertical coordinate system 
for the surface from a drop-down list.

Creation: 

Data Start Date Date can be modified using the drop-down 
calendar

Field Sheet layer

Attribute layer

GeoBaR group layer

GeoBaR parent 
layer

Mosaic parent
layer

Attribute layer
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The properties for the child layers of a mosiac are the same as 
for other surface attribute layers.

GeoBaR layers
The Properties for the GeoBaR parent layer list the GeoBaR 
source files. It also contains the switch to apply consistent 
properties for all GeoBaRs. 

Sync Properties are set to True by default. This controls that 
when a property on a GeoBaR layer is set or changed, all other 
GeoBaR layers are changed to match it. 
To have different properties apply individual GeoBaRs:
1. De-select the check box to set the value to False. 

If there are GeoBaRs open in the Display, the Sources fields will 
display the source files for the open GeoBaRs.
The Auto-Adjust Histograms check box allows the same range of intensity 
values (min/max) to be set for all GeoBaRs created. By default this is set 
to True. 

To disable this auto-adjust and have different intensity values 
for GeoBaRs: 

Data End Date Date can be modified using the drop-down 
calendar

Comments Click in the field to type in comments. .

Platform Name Click in the field to type in comments. 

Properties Function
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2. De-select the Auto-Adjust Histograms check box to set the value to False.

The Show All Sediment Analysis Patches option is turned off (set to False) by 
default. 

To display all patches within the selection area along a line, 
when the sediment analysis tool is activated:
3. Select the Show All Sediment Analysis Patches check box to set it to True.

GeoBaR settings in the Properties window are saved when a 
project is saved to a session file and will be displayed and 
applied when the session file is reopened. 



3
 Process LIDAR Data

LIDARLIDAR data converted to HIPS format can be viewed and cleaned 
in Subset or Swath Editor. You can select, superselect and flag the status 
of soundings. Data can also be rejected or accepted. 

If waveform data is available it can be viewed in a waveform viewer.

In this chapter...
LIDAR DATA IN HIPS................................................. 28
WORKFLOW ................................................................ 30
DISPLAY LIDAR DATA ..................................................... 32
SELECTING DATA ......................................................... 38
SOUNDING QUALITY AND STATUS FLAGS .......................... 40
CLEANING SOUNDING DATA ........................................... 42
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Process LIDAR Data: LIDAR Data in HIPS

LIDAR Data in HIPS
Light detection and ranging (lidar) uses laser technology to 
measure bathymetry. In such surveys, laser wavelengths are 
transmitted to the water from a transceiver mounted on a plane 
or helicopter. Sounding data is returned to the transceiver in a 
continuous stream that forms a swath-like pattern. 
 

LIDAR Projects
LIDAR projects are organized in the same Project-Vessel-Day-
Line hierarchy as sonar projects. Each project contains the 
following files:
• HIPS Vessel File
• an Observed Depths file (along-track and across-track 

sounding positions before merge)
• a Processed Depths file (lat/long sounding positions after 

merge)
• a bathymetry file
• gyro data
• navigation data
• tide data
As well, LADS, SHOALS and Hawkeye projects can contain 
waveform data. LAS format data can also be opened in HIPS, 
but this format does not contain waveform data.
For conversion of LIDAR data to HIPS format, see the Convert 
Data chapter of the HIPS and SIPS Users Guide. 

HIPS currently supports these systems:

• Laser Airborne Depth Sounder (LADS)
• Scanning Hydrographic Operational Airborne LIDAR Survey 

(SHOALS) system
• Hawkeye from Airborne Hydrography AB (AHAB). 
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Data format
Soundings are recorded in a bathymetry file. Each sounding has: 
• a latitude and longitude position
• a depth value
• a time stamp
• an across-track and along-track position
• a quality flag
• a status flag.
Waveform data can also be included for each sounding. If 
available, this data is stored in a waveform file (see “WAVEFORMS 
VIEW” ON PAGE 36).
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Workflow 
LIDAR projects follow a similar workflow to other processing in 
HIPS. The following chart shows the most important steps for 
cleaning lidar data
 

1. Create a new HIPS Vessel File (HVF) containing only lidar and 
navigation information.

2. Create a Project-Vessel-Day directory tree structure to store data.

3. Convert raw data files to HIPS format and store data in the project 
directory.

4. Save the currently open data as a session file. 
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5. Create a field sheet within a defined area and with a defined coordinate 
system.

6. Process data using Subset Editor or Swath Editor.

7. Process Data in Subset Editor
• Create a Subset Tile layer within the field sheet.
• Open the Subset Editor and use the subset bounding box to select 

an area in the Subset Tile layer.
• View and clean data .
• Change the quality flag of soundings, if needed.
• Create designated soundings using the Designate Sounding and 

Find and Designate commands.
• Track the progress of cleaning by flagging tiles as Complete, 

Partially Complete or Reset.

8. Process Data in Swath Editor 
• Open the Swath Editor to examine and clean sounding data.
• Select soundings to view waveform data and other information.
• Change the quality flag of soundings, if needed.
• Reject data or change the status of a rejected sounding back to
• accepted.
• Create designated soundings using the Designated Sounding and
• Find Designated Sounding commands.

9. Create a BASE surface. 

10.Add contours and other layers.

11.Designate shoalest soundings .

12.Create a product surface.

13.Export finished soundings to a CARIS map or other format.

.
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Display lidar data
LIDAR data can be processed in either Swath Editor or Subset 
Editor, depending on how you want to view the data. 
If you use Subset Editor, the data can be viewed with the 3D and 
2D view and cleaning progress can be tracked using the Subset 
Tile function. 
If Swath Editor is used the LIDAR tab and waveform view are 
also available.
The following image shows SHOALS lidar data displayed in 
Swath Editor. 

Waveform 
ViewsLIDAR 

properties in 
Control 
window

LIDAR 
toolbar
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LIDAR tab
Properties and controls for lidar data are located in a tab in the 
Control window. 
• In Swath Editor, the LIDAR properties are displayed on a 

tabbed page in the Swath Editor tab
• In Subset Editor, these are displayed in the LIDAR layer in 

the Subset Editor tab.
The LIDAR tab in Swath Editor is illustrated below. 

To display the LIDAR controls in Swath Editor:
1. Select a line and open Swath Editor.

2. Select the View Waveforms command.

The LIDAR tabbed page appears on the Swath Editor tab in the 
Control window.

M
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u Edit > LIDAR > View 
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To display the LIDAR tab in Subset Editor:
1. Open Subset Editor and make a subset of the LIDAR data. 

2. Highlight the LIDAR layer in the data tree on the Subset Editor tab. 

3. Select soundings in one of the Swath Editor view windows. 

Properties The following properties for the selected sounding are displayed 
in the LIDAR tab in both editors:
• Point Size: Change the size of the points that describe the 

waveform graphs.
• Connect Points: Select this option to draw a line through each of 

the points in the graph.
• Max Y Axis Value: Change the scale of the Y axis to display less or 

more of the waveform. 
• Line: Identifies the superselected line.
• HIPS Time Stamp: Year-Month-Day-Hour-Minute-Seconds-

Milliseconds.
• LIDAR Time Stamp: 

• Half milliseconds since midnight (SHOALS only).
• Microseconds (Hawkeye data).

• Profile (number): The along-track position of the sounding
• Beam (number): The across-track position of the sounding.
Observed fields display the sounding values when converted to 
HIPS format. If any processing (such as tide) is applied to this 
data the new value will be displayed in the Processed fields. 

• Detected : The value designated by the acquisition system as 
being the sounding depth. If a Detected depth is selected, an 
asterisk is displayed beside the field.
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• Alternative: If the data includes an alternative depth value from 
the return, it will be displayed here. If you select an 
alternative depth, an asterisk is displayed beside the field. 
(See“SELECTING DETECTED AND ALTERNATIVE DATA” ON PAGE 40.)

• Confidence value: The confidence value for the sounding 
(SHOALS only).

• Tide: Tide data for the sounding, if there is any in the file. (Not 
all formats contain tide data, in which case the field shows a 
value of zero.) If tide data is added, data must be merged 
before tide value can be displayed. 

• Status: Current status flag for the selected sounding.
• Find LIDAR Time Stamp: Select a sounding by its time stamp. 

Time stamp for Hawkeye data must be entered in 
microseconds.

Note: Not all Hawkeye data contain alternate depths that can be 
highlighted or swapped with the primary depths.

Note: Hawkeye data does not contain tide data.
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Toolbar
The LIDAR toolbar controls the display and status options for 
soundings and associated waveform data in the Swath and 
Subset Editors. 

This is a floating toolbar that can be moved or docked anywhere 
in the HIPS main window. The tools on the toolbar become 
activated when Swath Editor is opened or data loaded to Subset 
Editor. 
If the LIDAR toolbar is not visible in the interface, 
1. Select the LIDAR toolbar command to display it.

Waveforms View
The Waveforms view displays the waveform data for a super-
selected sounding (see “SELECTING DATA” ON PAGE 38 for more 
information on superselection). The display in the Waveforms 
view is determined by the data format being viewed. 
1. Select the View Waveforms command.

2. Select data in any of the Swath Editor or Subset Editor views.

The first sounding in the selection (i.e. with the lowest beam and 
profile number) is superselected when the Waveforms window is 
opened.

LADS The LADS waveform window contains one panel that shows a 
graph of specific waveform data for the superselected sounding. 
One line represents the detected depth sounding and the other 
line represents the alternative depth sounding (if applicable)

SHOALS There are four panels in the waveform view for SHOALS data. 
Each panel shows a graph of specific waveform data for the 
superselected sounding. The X axis represents time and Y axis 
represents amplitude.
To view the complete waveform for SHOALS data, the Y-axis 
scale may have to be increased. The default value is 255.

View the 
Waveform

Highlight 
Alternative Depths

Reject by 
Disabling 
Sounding

Swap to 
Alternative

Keep Detected

View All 
Alternative Depths
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1. Click the Max Y-Axis Value up or down arrow buttons until the entire 
wave form is within view.

Point display The points that describe the waveform graphs can be increased 
or decreased.
1. Select the LIDAR tab in the Control window if it is not already 

displayed.

2. Click the Point Size up and down arrow buttons.

As the value changes, the displays in the four views are redrawn 
to show the points at the selected size.
3. To draw a line through the points in the view, select the 

Connect Points check box.

Hawkeye The waveform viewer for Hawkeye data was developed by 
AHAB. This viewer is activated when you select Hawkeye data 
in any of the Swath Editor or Subset Editor views. The Hawkeye 
viewer displays information for the currently superselected 
sounding, if it has waveform data. 

Note: Not all Hawkeye soundings contain waveforms that can be 
viewed. If a waveform cannot be found, an error message appears 
in the Output window.
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Selecting Data
Open data LIDAR data can be viewed and cleaned in the Swath and Subset 

Editors. 
1. Open either the Swath Editor or the Subset Editor. 

If you are using Subset Editor, 
2. Select an area and load the data.

3. Select the View Waveform command.

The Waveforms window (see “WAVEFORMS VIEW” ON PAGE 36) is 
displayed and the LIDAR tab is displayed in the Control 
window. (Nothing is visible in the Waveforms window until data 
is selected.)

Selection/
Superselection

There are two levels of selection in LIDAR mode: regular 
selection and superselection.
• Selection refers to all highlighted soundings in any of the 

editor views ( e.g., Profile View, 2D View, etc.). 
• A superselected sounding is a subset of the selected soundings 

and is highlighted in a different colour from the regular 
selection. When a group of soundings are selected, the first in 
the selection (i.e. the lowest beam and profile number) is 
automatically super-selected.

All selected soundings can be queried or rejected, but you can 
only view waveform data and sounding attributes for one 
superselected sounding at a time. The superselection option is 
only active when the Waveforms window is open.
4. Choose a selection tool from the Select menu. The Edit By Range option 

is selected by default.

5. Select data in any of the views.

The selected data is highlighted in the selection colour 
determined in the Tools > Options > Display > LIDAR dialog 
box. The superselected sounding is displayed in the Plan View 
(in Swath Editor) and the 2-D and 3-D Views (in Subset Editor).
Waveform data for the superselected sounding is displayed in 
the Waveforms view.

Move to next sounding You can use the LIDAR tab to superselect a neighbouring 
sounding in the current selection.
6. Click the Next or Previous button in the LIDAR tab of the Control 

window. This moves you to the next or previous selected sounding by 
ping and beam number.

The graph in the Waveforms window is refreshed to show the 
new data and the attributes for the newly superselected 
sounding are shown in the data fields on the LIDAR tab.
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Find sounding You can also superselect a sounding by locating it by its time 
stamp (SHOALS data only).
1. Type the value of the lidar time stamp in the Time Stamp field.

2. Click Find.

The sounding with that time stamp is highlighted as 
superselected and the sounding data is displayed in the LIDAR 
tab fields.

Superselect data in the 
Worksheet window

Queried data can also be superselected.
1. Select data in any of the views.

2. Select the Query command.

The selected data is displayed in the Query tab of the Worksheet 
window.
3. To superselect a sounding, click a row so it is highlighted.

The beam is highlighted as superselected in the Plan View.
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Sounding Quality and Status Flags
When a lidar sounding is converted into HIPS, it is given a 
quality flag that can be changed during processing. This table 
shows the quality statuses that can be attached to a sounding.
 

Status flags Status flags are assigned to soundings during conversion, these 
status are determined from information provided by the specific 
acquisition format. 

Selecting Detected and Alternative Data
In some instances, two depth values (detected and alternative) 
are returned. You can decide which depth value is most relevant 
and change the sounding's quality flag accordingly (see “SOUNDING 
QUALITY AND STATUS FLAGS” ON PAGE 40). 

Highlight alternative 
soundings

This command highlights soundings that contain valid 
alternative depths. It does not select or superselect soundings.
1. Select the Highlight Alternative Depths command. This command only 

highlights data in the Plan View. 

Soundings with a Quality flag of 1, 2, or 3 are highlighted in 
colour that is set in the Tools > Options > Display > LIDAR 
dialog box.
You can select from three options:
• View all alternative depths

• Swap to alternative

Quality 
Flag Description

0 The sounding has a detected depth only. The alternative depth is 
invalid. 

1 The sounding has both a detected and a valid alternative depth. A 
quality control/assurance decision has not yet been made. 

2 The sounding has a detected depth and a valid alternative depth, and 
the user has decided to keep the detected depth.

3 The sounding has both a detected and alternative value, but the 
alternative value has been swapped with the detected value ). 

Depth values can be selected and changed in both the 
Swath Editor and the Subset Editor. 
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• Keep detected.
View all alternative 
depths

This command refreshes the display so that the alternative 
depths for soundings with a Quality 1 flag are shown. This is a 
useful tool for viewing the position of alternative depths in 
relation to neighbouring soundings.
1. Select the View Alternative Depths command.

The data in the Views refresh to display the alternative 
soundings.

Swap to alternative This command applies an alternative depth in a superselected 
sounding to the detected depth. With SHOALS data, the depth is 
swapped, and with LADS data, the depth and position are 
swapped.
1. Select soundings and superselect a sounding with a Quality 1 flag.

2. Select the Swap to Alternative command.

An asterisk beside the depth value indicates whether the 
detected or alternative depth is currently in the HIPS depth file.

Keep detected This command is used to verify that the detected depth is 
preferred over the alternative depth (see “SOUNDING QUALITY AND 
STATUS FLAGS” ON PAGE 40).
1. Select soundings and superselect a sounding with a Quality 1 flag.

2. Select the Keep Detected command.

The Quality flag is changed to 2. 
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Cleaning Sounding Data
Soundings can be assigned an Rejected by Disabling Sounding 
flag. These soundings are not included in the merge or any post-
processing operations. Data can rejected in the Swath and 
Subset Editors.
1. Select a sounding or group of soundings.

2. Select the Reject by Disabling Sounding command.

The soundings are now flagged as rejected.

To see which soundings have been rejected:
1. Select the Show Rejected command so the disabled soundings are 

visible.

To return rejected soundings to Accepted status:
1. Select the soundings.

2. Select the Accept command.
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Navigation Editor

Navigation Editor enables you to examine and clean position data for both 
the ship and towfish.

In this chapter...
NAVIGATION EDITOR INTERFACE ..................................... 44
NAVIGATION EDITOR TAB ............................................... 46
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Navigation Editor Interface 
To open Navigation Editor: 
1. Select a track line.

2. Select the Navigation Editor command.

The Navigation Editor components are displayed in the HIPS 
and SIPS interface. 
 

Navigation Editor is composed of three time-series graphs and 
the Navigation Editor tab in the Control window. The three 
graphs display information that is calculated between points in 
the recorded navigation data:
• Speed: Calculated speed.
• Distance: Calculated distance.
• Course Made Good: Calculated direction (in degrees) from one 

navigation fix to the next.
Navigation Editor shows the track lines as a series of continuous 
symbols, with each point representing a navigation fix. These 
symbols become visible as you zoom in on the selected line. 
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You can change the CARIS feature code used to represent these 
navigation symbols using the Options in the Tools > Options 
General dialog box. 
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Navigation Editor tab
Display of various aspects of the data in Navigation Editor is 
controlled by the options on the Navigation Editor tab in the 
Control window.

Resize data points The point symbols can be resized to a maximum of 10 pixels.
 1. Click the up or down arrow buttons beside the Point Size box to change 

the size of the symbols.

The view in the Display window is refreshed so the navigation 
data is shown in the new point size.

Time Stamps Display lines to represent time stamps in Navigation Editor 
windows. The time stamp interval is displayed in seconds and 
can be changed.
1. Select the Time Stamp check box to display time stamp lines.

2. Click the up or down arrow buttons beside the Interval to select the gap 
(in seconds) between time stamps.
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Set minimum/maximum 
of line

When this option is selected the vertical scaling of the graphs 
fits the maximum and minimum range of values for the entire 
line. Otherwise the vertical scaling of the graphs fits the max-
min range of the data currently in view.
1. Open the Control window.

2. Select the Navigation tab.

3. Select the Max-Min of Line check box.

Number of points displayed
Navigation Editor shows the track lines as a series of continuous 
symbols, with each point representing a navigation fix. (These 
symbols become visible as you zoom in on the selected line.)
Use this option to determine the number of points visible in the 
Display window. 
1. Open the Control window.

2. Select the Navigation tab.

3. Select either the Manual or Fixed check boxes (Manual is selected by 
default).

If you selected the Fixed check box, enter the number of navigation points 
to be displayed by clicking the up or down arrow buttons.

This option determines the number of points visible in the 
Display window. 
• When Manual is selected, use the zoom tools to determine how 

many navigation points are visible in the Display window.
• When Fixed is selected, a set number of points are displayed in 

the window.
1. Select either the Manual or Fixed check boxes (Manual is selected by 

default).

2. If you selected the Fixed check box, enter the number of navigation 
points to be displayed by clicking the up or down arrow buttons.

The amount of data displayed in the three graph views is 
determined by the number of navigation points visible in the 
Display window.

Connect points Join the displayed navigation point symbols with a line 
representing the current interpolation method.
1. Open the Control window.

2. Select the Navigation tab.

3. Select the Connect Points check box.

The navigation points are connected by line drawn according to 
the current interpolation method of the line.
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Gyro indicator line A gyro indicator line that shows vessel heading can also be 
displayed in the Navigation Editor. This feature is useful for 
detecting dramatic changes in heading that could effect data 
acquisition.
1. Select the Gyro Indicators check box to display the gyro line in the 

Display window.

2. Click the up or down arrow buttons to select the size (in pixels) of the 
gyro indicator line.

3. Select a colour for the line from the Colour picker, or create a custom 
colour using the standard Windows Colour Palette.
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Side Scan Editor

Side Scan Editor provides tools for viewing and editing side scan sonar 
data, and for digitizing and editing contacts. 

In this chapter...
SIDE SCAN EDITOR WORKFLOW...................................... 50
SIDE SCAN EDITOR INTERFACE ...................................... 52
SIDE SCAN EDITOR CONTROLS ....................................... 55
EDIT SIDE SCAN DATA ................................................. 71
IMAGE PROCESSING...................................................... 79
CONTACTS .................................................................. 93
SIPS TEMPLATE WIZARD.............................................. 98
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Side Scan Editor workflow
In Side Scan Editor you can 
• use a waterfall display for editing 
• apply advanced Time Varying Gain controls 
• edit altitude data for side scan data 
• digitize and edit contacts.
The following diagram outlines the process for processing side 
scan data in SIPS. 

Altitude digitized side scan imagery can also be processed in 
Mosaic Editor. Mosaic Editor is also used to create mosaics from 
side scan data. See PROCESS IMAGERY DATA in the Users Guide. 



CARIS HIPS and SIPS Editors 51

Side Scan Editor: Side Scan Editor workflow

Data in Side Scan Editor can be viewed in either raw or 
processed mode. Processing can be applied to a single ping, to a 
range of pings, or to one (or more) track lines. 
1. If desired, the raw data may be edited by selecting, querying, rejecting 

or accepting pings. Rejecting pings removes them from consideration 
for any mosaics to be created from this data. (See “EDIT SIDE SCAN 
DATA” ON PAGE 71)

2. Once pings are edited, you may need to digitize the “first return” or 
altitude if the sonar did not detect and record this data during 
acquisition. The altitude is required to perform slant range correction. If 
digitized altitude data does exist, it may need to be edited first. (See 
“DIGITIZING SONAR ALTITUDE” ON PAGE 74)

3. With fish altitude and an average sound velocity, the raw data can be 
slant range corrected. Slant range correct data is shown in processed 
mode, where the across-track measurement is horizontal distance. 
(See “APPLY SLANT RANGE CORRECTION” ON PAGE 81)

In this processed mode, you can edit and query pings, make 
height and distance measurements, and mark and edit contacts. 

4. Use the correction tools to remove unwanted artifacts:
• “BEAM PATTERN CORRECTION” ON PAGE 83)
• “ANGLE-VARYING GAIN” ON PAGE 88 
• “TIME-VARYING GAIN” ON PAGE 89
• “DESPECKLE” ON PAGE 92)

The parameters for applying these correction tools can also be 
saved in a template file and loaded and applied again. (See “SIPS 
TEMPLATE WIZARD” ON PAGE 98). 

5. Create and edit contacts

See “CONTACTS” ON PAGE 93.
Side scan data can also be processed by creating GeoBaRs and 
mosaics in Mosaic Editor. (See “PROCESS IMAGERY DATA” ON PAGE 387).
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Side Scan Editor Interface
The Side Scan Editor consists of a data display window, toolbars 
and the Side Scan Editor tabs in the Control window. 
To open the Side Scan Editor:
1. Select a towfish track line in the HIPS and SIPS Display window.

2. Select a Side Scan Editor command.

When the Side Scan Editor is opened, the data for the selected 
track line is displayed in the Side Scan Editor preview window, 
which has a default location along the right side of the interface. 
As well, a histogram of the sonar file is displayed in the 
Worksheet window, and the Side Scan Editor toolbar and the 
Beam Correction toolbar are activated. 
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Side Scan data display
The Side Scan Editor data display window (also called the 
“waterfall” view) can be undocked and moved to another 
position, for example, at the bottom of the interface. 
There are two modes to display data in the SIPS Preview 
window:
• Raw: (the unprocessed sonar data). In raw mode the across-

track axis represents time, thus the data is shown in the 
sequence in which it was received. The central portion of the 
image still displays the water column. This mode will always 
show the raw data for the selected track line. 

• Processed: (the processed sonar data). In processed mode the 
across-track scale represents distance. The water column is 
no longer visible as it is removed during the slant range 
correction process. The data displayed in this mode will 
reflect the last processing done to it. 

1. Select a display mode.

The display is refreshed to show the data in the selected mode. 
The selected mode is indicated with a check mark in the menu.

Coverage outline A coverage outline in the Display window automatically 
highlights the location of the side scan data that is visible in the 
SIPS Preview window. The size of the coverage outline varies 
with the amount of side scan visible in the SIPS Preview 
window. The starboard and port areas of the coverage outline 
are appropriately colour coded, as illustrated below.
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Note: If the data does not fill the entire height of the Editor 
window, it will be displayed in the bottom of the window and 
can be processed normally. The empty area above the data 
will indicate “No data to display”.



54 CARIS HIPS and SIPS Editors

Side Scan Editor: Side Scan Editor Interface

Colours for outlines and selection are controlled from the Tools 
>Options >Display dialog box .

Compression The number of pixels used to display data in the Side Scan 
window is determined by the width of the display window and 
screen resolution. However, because the volume of data is often 
too great for the window to display all pixels, the imagery must 
be compressed.
There are three compression methods to choose from.
1. Select a Compression command. 

• Skip selects pixels for display at regular intervals across the 
track.

• Average compiles average pixel intensity within a group of 
pixels spaced at regular across-track intervals.

• Maximum selects the brightest pixels from groups of pixels at 
regular across-track intervals.

The display in the Side Scan Editor is refreshed to show the data 
according to the selected compression option. The default display 
uses the Skip option. 
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Side Scan Editor controls
The General tab of the Side Scan Editor contains controls for 
navigating and displaying data in the Editor window. This tab is 
visible in the Control Window when the Side Scan Editor is 
opened.

Across-track display The width of the ping shown in the SIPS Preview window can be 
increased or decreased by time or distance, using the controls in 
the Acrosstrack Display Limit fields on the General tab.

To set across-track display limits:
1. Make sure the Control window is open.

2. Select the General tab from the Side Scan Editor tab.

3. To have the entire width of the ping is shown in the Editor, leave the 
Acrosstrack display limit box unchecked.

4. To limit the width of ping displayed, check the Acrosstrack display limit 
box and select which value to use as limiter:
• Milliseconds: Click the arrow button to change the time value. This 

option is automatically selected. 
• Metres/Feet: Click the arrow buttons to change the distance value. 

As time or distance is incremented or decreased, the amount of 
the data is displayed in the window is changed.
The units of distance units can be changed using the Display tab 
in Options on the Tools menu. 

Enable Range display The range display runs across the top and bottom of the SIPS 
Preview window. In Raw mode the range displays time intervals 
in milliseconds. In Processed mode, distance is displayed in the 
units you have set in the Tools >Options >Display dialog box. 
1. Select the Enable Range Display check box in the Side Scan Editor 

General tab.
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The colour of the range display is set to the same colour used for 
measure/offset tools in the Side Scan Display Options of the 
Tools menu.
 

16-Bit Shift Factor An 8-bit colour display in a 16-bit processed data set can be 
enhanced by bit-shifting to select which 8 bits are used to 
generate the display. This can create a more even distribution of 
pixels.
1. Make sure that 16-bit processed data is displayed in the Side Scan 

Editor.

2. Click the up or down arrow keys beside the 16 Bit Shift Factor field to 
select a value from 0 to 8.

The display is refreshed.
Ping selection The two Selection fields display the start and end ping numbers 

when you select part of the trackline displayed in the Editor 
window. You can use these fields to select specific start and end 
pings. 



CARIS HIPS and SIPS Editors 57

Side Scan Editor: Side Scan Editor controls

Colour Mapping
Colour maps provide a clear visual representation of sonar 
intensity levels along the track line. Colour mapping is applied 
to the histograms displayed in the Worksheet window, as well as 
the port and starboard sections of ping in the SIPS Preview 
window.
You can select different colour maps for port and starboard 
sections, or select a single colour map for both sections. All 
colour maps are stored with a .cma extension in the directory 
…\Hips\System.

Change from GreyScale To change the colour mapping from the default setting of 
GreyScale: 
1. Open the Control window and select the Colour tab from the Side Scan 

Editor tab.

2. Select either Port, Starboard or Both to apply new colour to.

3. Select a colour map from the drop-down menu (the default colour map 
is GreyScale.cma).

When the colour map is chosen, both the histogram and the ping 
window are refreshed, so that the port and starboard sections (or 
both) display the selected colour mapping.

In the Histogram, the horizontal axis represents the intensity 
range of the pixels in the sonar file and the vertical axis 
represents the distribution of pixels in the editor. 
Use the slider bar below the histogram in the Worksheet window 
to adjust colours. Each colour in the histogram has a slider 
control associated with it. 
1. Move the slider to adjust the pixel value of that colour in the histogram 

and in the ping.

The value shown in the Control window adjusts as you move the 
sliders.
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Colour display can be adjusted also using the other options:
• Blend will blend the colour borders
• Delete Colour will remove it from the list, and from the areas 

that it colours 
• Clear will remove all colours. To view ping clearly, restore 

GreyScale colour map.
Custom colour maps You can create custom colour maps using either the Colour tab 

or the sliders below the histogram in the Worksheet window.
1. Make sure both the Worksheet and Control windows are open.

2. Click Add Colour, or click on a slider to open the colour mapping 
controls.

 

The Value field shows the pixel value of the displayed colour.
The pixel values range from 1 to 255 with the first colour always 
assigned to pixel value 1. Pixel value 0 is always assumed to be 
transparent.
3. Enter a pixel value for the colour, as needed.

4. Click on the button to open a colour palette

5. Select a colour from the colour palette or click Create Custom Colour 
to create a custom colour from the standard Windows colour picker.
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6. Click OK.

The new colour and its assigned pixel value is added to the 
listing in the Control window, and applied to the histogram in 
the Worksheet window. The colour of the ping in the Side Scan 
Editor also changes to display the new colour in the appropriate 
areas.
7. Repeat Steps 2 to 6 to insert more colours, as needed.

As you select more colours, the colour values and the depths are 
displayed in the Control window. 

Reverse Sonar recorders have traditionally used dark colours to 
represent high signal returns. You may want to use the Reverse 
option to change the order in the colour map to reflect this 
practice. 
To reverse the colour map order, click Reverse.
8. Click Save As to retain the settings as a colour map.

The Save As dialog box is displayed.
9. Type a file name for the colour map.

Toolbar
The Side Scan Editor toolbar is displayed in the interface when 
the editor is started.
The toolbar can docked or undocked, or removed from the 
interface like other toolbars. Below is an example of the toolbar 
in the undocked position.

The toolbar contains controls to navigate through the track line 
and perform other functions. 

Toolbar Buttons Purpose

Playback (see “NAVIGATE IN SIDE SCAN 
EDITOR” ON PAGE 60)
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Navigate in Side Scan Editor
You can navigate up or down the track line with: 
• the scroll bar on the SIPS Preview window
• the mouse wheel
• the keyboard
• the Playback controls. 

Scroll bar • Clicking the scroll arrow buttons moves the view in the editor 
forward or backward by a single ping.

• Clicking the scroll bar, or dragging the scroll box forward or 
backward increments your view by a set of pings.

Mouse wheel Alternately, you can move up or down the track line by turning 
the mouse wheel (if available).

Keyboard You can also navigate up or down the track line using the 
keyboard.
• Press <Page Up> or the space bar to move the preview forward 

by one “page” (the height (# of pings) visible in your SIPS 
Preview window is the increment).

Zoom (see “ZOOM” ON PAGE 62)

Select (see “SELECTION” ON PAGE 62)

Measure distance and shadow (see 
“MEASURE DISTANCE” ON PAGE 64 and 
“MEASURE SHADOW” ON PAGE 65)

Digitize (see “DIGITIZING SONAR 
ALTITUDE” ON PAGE 74)

Contacts (see “CREATE CONTACTS” ON 
PAGE 93)

View waveform (see “SIGNAL DISPLAY 
WINDOW” ON PAGE 68)

Revert and reapply (see “REVERT/
REAPPLY” ON PAGE 79

Toolbar Buttons Purpose
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• Press <Page Down> or hold the <Ctrl> key while pressing the 
space bar to move the preview back by one “page”.

• Press <Home> to go to the start of the track line, and press 
<End> to go to the end of the track line.

Playback The Side Scan Editor can automatically scroll data from the 
start of the track line to the end by using the Playback controls. 
 

The view in the Side Scan Editor will scroll at the speed set on 
the Side Scan tab of the Control window
The ping coverage outline in the Display window moves with the 
display in the Editor.

1.Click Start to go to the start of the track line. 

 2.Click Play Forward to start scrolling the data.

The Side Scan Editor moves up the track line, ping by ping, until 
it reaches the end of the surveyed data. 
3. Click Play Reverse to scroll back down the track line.

4. Click Start to reset the view to the first ping.

5. Click Stop to pause the scrolling 

6. Use Page Forward and Page Reverse to move along the trackline in 
larger increments.

Playback speed You can adjust the scrolling speed for automatic scrolling in the 
Playback Speed field. 
1. Make sure the Control window is open and Side Scan Editor tab is 

displayed.

2. Select speed value from the Playback Speed field in the General tab..

View contacts while 
scrolling

If you want your contacts to remain visible in the waterfall 
display while scrolling or using the Playback functions
1. Select Side Scan Editor from the Tools > Options > Display tab. 

2. Select the Display contacts during playback check box, and click Apply. 
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Zoom
You can magnify an area in the Side Scan window with the Side 
Scan Editor Zoom tool.
1. Select the Side Scan Zoom tool.

2. Press and hold the mouse button and drag the cursor over the area you 
want to enlarge.

A new window displaying the enlarged area will open.
You can display the image so that the entire zoomed area fits the 
zoom window or you can scale the image according to a selected 
percentage.
3. Right-click the mouse in the zoom display window and choose any of 

the following options from the pop-up menu:
• Select the Fit to Window option so that the entire area of the zoomed 

image is displayed in the window.
• Select the Aspect Ratio to keep the same height and width ratio for 

the zoomed area. When this option is cleared, the image is resized 
so that it fills the entire zoom window.

• Select the Scale option to resize the zoomed area to a scale. The 
scale is selected from the drop-down list. When a scale is selected, 
the image is displayed according to the selected percentage. 

• Select Close to close the window.

4. You can use the Measure Distance and Measure Shadow tools in the 
Zoom window (see “MEASURE DISTANCE” ON PAGE 64 and “MEASURE 
SHADOW” ON PAGE 65). When you release the mouse button, the results 
are shown in the Contacts tab in the Control Window.

5. Deactivate the Zoom tool when finished.

Selection
Data can be selected in the Side Scan Editor using the Side Scan 
selection tool. The selection tool can be used to select a range or a 
single ping within that range. Selected data can be viewed, 
edited, or corrected using a variety of tools.
To range-select data: 
1. Choose the Select Side Scan button on the Side Scan Editor toolbar.

The cursor will become a cross-hair when positioned in the SIPS 
Preview window.
2. Press the mouse button and drag the cursor across the area of the 

Editor that you want to select.

When you release the mouse button, the selected range is shown 
bounded with a rectangular yellow box:
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The range remains selected until you click in the Editor window 
again.
To select a single ping:
3. Select a range of side scan (see above).

4. While the range is selected, press the <Up Arrow> key, which produces 
a third horizontal line representing the selected ping.

5. Continue pressing the <Up Arrow> key to move the selection up, or 
press the <Down Arrow> key to move the selection down.

Select by ping number You can also use the Selection fields on the General tab of the 
Side Scan Editor Control window to select a range in the Editor 
window. 
When you make a selection in the Editor window the start and 
end ping numbers of that selection are displayed in the General 
tab. To refine your selection, enter the specific ping numbers 
fields to specific start and end pings. 
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Superselection Superselection is selecting data within an already selected 
range. You can superselect pings from the Worksheet window 
and display the superselected data in the Side Scan Editor. 
1. Select a range of side scan data.

2. Select the Query command.

A table listing the pings in the selection is displayed in the 
Query tab of the Worksheet window. 
 

3. To superselect a single ping, select the row in the Selection tab. 

The superselected ping will be highlighted within the selection 
in the Side Scan Editor.
3. To superselect a range of pings, click in the first column on the 
first row of the range and drag the mouse through to the last row 
of the range you want to select.
A rectangle is displayed containing the superselected range of 
pings within the selection.

Measure Distance
Measure distance This tool enables you to measure distance between two points 

with the mouse. This feature is used in processed mode, in either 
the SIPS Preview window or in the Side Scan Zoom window. 
Distance units are determined by the settings in the Display tab 
of the Tools >Options dialog box .
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1. Make sure the side scan display is in processed mode.

1. From the Side Scan Editor toolbar, select the Measure Distance tool.

2. Press and hold the mouse button, and drag the cursor across the Side 
Scan Editor. 

As you drag the cursor across the data, the distance is displayed 
at the cursor.

Measure Shadow
This tool enables you to determine the height of an object by 
measuring its shadow. This feature is only available in 
processed mode, and can be measured in either the Side Scan 
Editor or in the Side Scan Zoom window.
1. Make sure the side scan display is in processed mode.

2. Select the Measure Shadow tool.

3. Press and hold the mouse button, and drag the cursor horizontally 
across the Side Scan Editor.

The height measurement is shown in the side scan window.
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Side Scan Editor and Swath Editor
The Swath Editor can also be open at the same time as the Side 
Scan Editor.

When the Side Scan is open in this mode, the playback functions 
used to scroll the track line, are unavailable. You can, however, 
move up and down the track line by scrolling the Plan View in 
the Swath Editor.
All other Side Scan functions and tools are available.
When both the Side Scan and Swath Editors are open, a 
coverage outline of the multibeam data is displayed in the Side 
Scan Editor. This feature is useful when the across-track 
coverage of the multibeam is less than that of the side scan. 

Swath Time Offset If the multibeam data was recorded from a vessel and the side 
scan from a tow fish, then the coverage outline will not be in the 
correct along-track location. 
The Swath Time Offset adjusts the along-track locations of the 
swath outline in the Side Scan Editor by applying a time 
correction value. The time correction value can be either positive 
or negative. Negative values are used for track lines where the 
side scan sonar is positioned before the multibeam echo sounder.

Side Scan Editor Coverage outline for multibeam data
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To adjust the swath time offset:
1. Make sure the Side Scan Editor is open. (The Side Scan Editor tab in 

the Control window will be visible.)

2. Click the <Up> or <Down> arrows for the Swath Time Offset field on 
the Side Scan editor tab until the correct delay (in seconds) between 
the vessel and towfish is displayed.

Swath Time 
Offset field
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Signal Display Window
The Side Scan Editor includes a Signal Display Window for 
viewing sonar intensity levels. This window provides a plot of 
signal intensity against across-track distance (or time, in raw 
mode). The pre-and post-processing state of any correction can 
be compared using the Revert and Reapply functions
The Signal Display Window can display a mean of all sonar 
intensities in a selection or the sonar intensity values for a 
single ping. The display can be switched back and forth between 
mean and single profile modes by use of the buttons on the 
toolbar.
The Signal Display Window can be used in both the raw and 
processed modes.
When the Signal Display Window is reopened, it will remember 
its previous setting and display either the mean intensity values 
for the entire selection or the intensity values of a single profile.

Open Signal Display Window
1. Select a range in the Side Scan window using the Side Scan Selection 

tool (see “SELECTION” ON PAGE 62).

2. Select the Signal Display Window tool.

The Side Scan Signal Display Window is displayed.

The vertical axis on the graph represents intensity level of the 
signal(s) being examined. The horizontal axis represents either 
time or slant-range distance depending on the display mode of 
the Side Scan Editor.
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View Selection Mean
The mean of the intensity values in the selected range can be 
displayed. 
1. Select the View Selection Mean tool.

View Single Ping
You can also view signal intensity for a single ping.
1. Select the View Single Ping tool.

The Signal Display Window is refreshed to show the sonar signal 
intensities for the single ping selected in the Side Scan window.

Pressing the Up Arrow key while an area of the side scan data is 
range selected will select a single ping
2. Use the Up and Down arrow key to view the sonar intensities for other 

single pings.

As you scroll through the selected range, the Signal Display 
Window will refresh to show the intensity values for each ping. 
The ping number is displayed in the top-right corner of the 
Signal Display Window in this mode. The location of the ping is 
also indicated by a new line within the selection. The single ping 
selection always defaults to the first ping in the selection. 
You can view the position and specific intensity values of points 
by clicking on any point in the graph in the Signal Display 
Window. The intensity and time/distance values for that point 
are shown in a tool tip.
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Tool tip
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Edit Side Scan Data
In Side Scan Editor you can reject or accept lines as you do in 
other HIPS and SIPS editors, except that you select a ping 
rather than an individual sounding or beam. (This line editing 
does not need to be done within the Side Scan Editor, it can be 
done in the HIPS Display window.)
“ACCEPT/REJECT/QUERY” ON PAGE 71

If navigation sensor data has been edited with in Navigation 
Editor it may be necessary to recompute towfish navigation. (See 
“RECOMPUTE TOWFISH NAVIGATION” ON PAGE 73.)
If you intend to apply a slant-range correction, the altitude of the 
sonar must be known. If this is not already logged with your 
data, the altitude must be digitized. (See “DIGITIZING SONAR ALTITUDE” 
ON PAGE 74.) 

Accept/Reject/Query
You can change the status of an entire ping or of only the 
starboard or port side.

1. From the Side Scan toolbar, use the Side Scan Selection tool  

to select the range of pings from the SIPS Preview window (“waterfall 
view”) to be accepted or rejected (see “SELECTION” ON PAGE 62).

2. [Optional] From the HIPS Edit Toolbar, select Edit Port Side Only or 
Edit Starboard Side Only. 

3. Select the desired status from the menu or toolbar: Accept or Reject.

When a ping is rejected in the Side Scan Editor, it is given a 
status flag that excludes it from further processing in SIPS.
4. Select the Reject command.

The status of the ping or range of pings is set to Rejected. 
However, Rejected data is not deleted and can be changed to 
Accepted status again with the Accept command. 

Accept To make rejected data available for further processing in SIPS: 
1. From the Side Scan toolbar, use the Side Scan Selection tool to select 

the rejected pings (see “SELECTION” ON PAGE 62).

2. Select the Accept command.

Previously rejected data is now flagged as accepted and is visible 
in the Side Scan Editor.
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Query Use the Query function to view information about selected pings.
1. From the Side Scan toolbar, choose the Side Scan Selection tool and 

select a range of pings to be queried (see “SELECTION” ON PAGE 62).

2. Select the Query command.

Information about the selected data is shown in the Selection tab 
of the Worksheet window. 
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Recompute Towfish Navigation
To compute towfish navigation from the ship’s navigation 
requires a horizontal distance and direction from the ship’s 
towpoint location to the towfish. The towpoint is defined in the 
vessel file.
• Horizontal distance. Recorded horizontal layback data or 

actual cable length both share the same data structure in 
SIPS called SSS Cable Out. SIPS can distinguish between the 
two by the towfish sensor depth data. If the sensor depth data 
is zero, the horizontal layback is used. If the sensor depth 
data is non-zero it will be combined with the cable out data 
using trigonometry to produce horizontal distances. All 
distances to the towfish are applied from the towpoint 
position on the ship as defined in the vessel configuration file.

• Direction. The direction from the ship’s towpoint location to 
the towfish is derived using a “follow-the-dog” method. The 
average of the first 30 seconds of the ship’s “course-made-
good” is used for the initial direction. Thereafter, each 
successive position computed for the towfish occurs along the 
direction from the next ship’s position to the previous towfish 
position.

If horizontal layback or tow cable length data is not available, or 
if the Recompute Towfish Navigation step is not executed, then 
the recorded towfish navigation data converted into SIPS is used 
for generating the positions of contacts and for mosaics. 
If towfish navigation is not available at all then the position of 
the side scan imagery data is assumed to be the same as the ship 
navigation data.
Navigation data for towed sensors can come from the following 
sources:
• If computed during data logging and stored in the raw side 

scan format, it can be converted directly into the SIPS towfish 
navigation data structure. The Recompute Towfish 
Navigation process is therefore not required.

• It can be computed by SIPS if specific sensor data is available. 
SIPS requires ship navigation data with cable out and towfish 
depth to compute towfish navigation, or ship navigation with 
horizontal layback.

If you want SIPS to compute the towfish navigation data:
1. Select one or more towfish track lines.

2. Select the Recompute Towfish Navigation command.

The Recompute Towfish Navigation dialog box is displayed.
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u Process > 
Recompute Towfish 
Navigation
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.

Towfish sensor data can be smoothed in the Attitude Editor (see 
“ATTITUDE EDITOR” ON PAGE 572) and this data can be applied when the 
towfish navigation is computed. 
3. Check the box for the sensor data to apply.

4. Select the Recompute Contact Positions check box to update the contact 
positions based on the new navigation data.

5. Select either Ship Gyro or Ship Course Made Good to be applied.

6. Click OK.

If contacts are contained in the track lines where towfish 
navigation has been updated, you must update the contact 
positions to match the new navigation (see “RECOMPUTE CONTACT 
POSITIONS” ON PAGE 97).

Digitizing Sonar Altitude
Before side scan data can be processed, the altitude of the sonar 
must be known. With some sonars, altitude is logged in the raw 
data files and is converted by SIPS. However, in other cases, 
altitude is not logged or is logged and needs to be edited. The 
Side Scan Editor provides automated and manual tools to 
digitize the bottom directly from the side scan trace.
A raw side scan sonar display with a digitized seabed is shown 
below.
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Digitization and colour 
maps

Sometimes there is no clear distinction between the water 
column and the seabed. You can compensate for this by 
adjusting the display of intensity values in the editor so that the 
seabed and water column are clearly outlined. Also see “COLOUR 
MAPPING” ON PAGE 57.
1. Make sure that only two colours are displayed in the editor (for 

example, GreyScale.cma).

2. Use the sliders in the colour histogram to adjust the display in the 
editor.

3. Once the there is clear distinction between the water column and 
seabed use the digitizing tools to trace the first bottom return.

4. To remove the digitized lines, select the Clear command.

Automatic digitizing
The automatic digitizing method traces the first bottom return 
using a sophisticated multi-pass algorithm. Automatic digitizing 
is most effective when there is a clear distinction between the 
water column and the bottom. This method can be applied to a 
range of pings or to the entire line.
Settings for automatically digitizing the side scan return are in 
the Altitude tab of the Control window.

Offset from nadir

Digitized 
seabed
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The Altitude tab options are described below in the order that 
they appear in the tab. While the Contrast Step Size and Max Height 
Changes are compulsory for digitizing, the other options can be 
applied depending on the specific conditions of your data.

Contrast Step Size The Contrast Step Size and Max Height Change options must be set to 
correctly auto digitize the side scan.
The Contrast Step Size is the minimum difference in contrast 
expected between the intensity values of the water column and 
the seafloor. The Signal Display Window may be helpful in 
determining a good step size.

Max Height Change The Max Height Change is the maximum allowable ping-to-ping 
change in detected bottom position (in pixels). It is a restriction 
on the variation anticipated in detected bottom position. It could 
be visualized as error bars guiding the algorithm along the 
bottom.
1. Use the <Up> or <Down> arrow buttons to select the percentage for 

the Contrast Step Size and Max Height Change values.
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Offset from Nadir Strong solid returns in the water column, such surface 
reflections, can be compensated for by setting an offset from 
nadir in raw data mode.
2. Set the value in milliseconds for an Offset from Nadir by clicking the up or 

down arrow buttons.

3. Select Show Offset from Nadir to display the offset visually as a dashed 
line. 
• The line colour is set to the Measure / Offset tools colour in Tools > 

Options > Side Scan Editor.
• The thickness of the line is set in the Line thickness field on the 

General tab in the Side Scan Editor Control tab.

Verification The verification option tests the detected point to see if its 
intensity is consistent with nearby values further across-track 
that should also represent seafloor.
Its purpose is to detect and ignore anomalous points in the water 
column (for example, noise from equipment, reflections off the 
surface, marine life), by checking to see if there is water rather 
than sea floor on the other side of a detected point.
4. Select the Verification check box.

5. Select a desired strength-level for the verification from the drop-down 
list. Choices range from “Very Weak” to “Very Strong”. The default is 
“Normal”.

Interpolation The Interpolation option fills along-track gaps in the detected 
bottoms.
6. Select the Interpolation option.

7. Select the size of the gap to be filled by clicking the up or down buttons 
beside the Max Gap Size field.

Moving Average Filter The Filter option smooths the digitized line.
8. Click the Moving Average Filter check box.

9. Click the <Up> or <Down> arrow buttons to select the number of pings 
used for averaging in the Filter Width field.

You can use the Auto Digitize tool, or use the buttons at the bottom 
of the Altitude tab to complete digitizing. If you are using the 
buttons, continue with Step 10, otherwise, go to Step 11.
10.Choose any of the following digitization options:

• Click To Start to extend the digitized region to the back of the entire 
line.

• Click To End to extend the digitized region to the end of the line.
• Click All to digitize the entire selection or the entire line. 

11. If you change a value in the tab, click Recalculate to update the 
Digitization.

12.Select Overwrite to enable re-digitization of selected areas without 
clearing. With Overwrite disabled, only zero-altitude/cleared fish 
heights will be available for digitization.
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13.Click anywhere on the seabed to select the start and end pings for 
digitization and also to indicate the side (port or starboard) on which to 
perform the calculations.

14.[Optional] Select the Clear command to remove the digitization.

Manual digitizing 
Add altitude lines by selecting areas along the first bottom 
return.
1. Select the Manual Digitize command.

2. Press and hold the mouse button and drag the cursor along the bottom 
contact. 

 

As you drag the cursor, a digitizing line is drawn in the window. 
When you digitize one side, the other side is automatically 
mirrored.
3. Alternatively, create a point-to-point line by clicking carefully along the 

first return.

4. Cancel the Manual Digitize tool when finished.

At any time during the digitizing process, you can select the 
Clear tool to remove the digitization.

Interpolate Selection
Interpolation digitizes a straight line between the fish height 
values found at the start and end of the selection. Any altitude 
data within the selection is overwritten during this operation.
1. Use the Side Scan Selection tool to select an area of raw mode data 

that has been digitized. (See “SELECTION” ON PAGE 62) 

2. Select the Interpolate Selection command.

The pixels between the digitizing points are interpolated and the 
digitizing lines are smoothed.

M
en

u Tools > Side Scan 
Editor > Altitude > 
Clear

To
ol

M
en

u Tools > Side Scan 
Editor > Altitude > 
Manual Digitize

To
ol You can also use the space bar to move along the track 

line while in digitizing mode.
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Image Processing
Side scan imagery has been traditionally processed on a line-by-
line basis, using a “waterfall” display, and a number of 
processes. These processes are available from the Process menu 
and the Process Side Scan toolbar: 

1. “SLANT RANGE CORRECTION” ON PAGE 80

2. “APPLY SLANT RANGE CORRECTION” ON PAGE 81

3. “BEAM PATTERN CORRECTION” ON PAGE 83

4. “ANGLE-VARYING GAIN” ON PAGE 88

5. “TIME-VARYING GAIN” ON PAGE 89

6. “DESPECKLE” ON PAGE 92

7. “PURGE REJECTED CONTACTS” ON PAGE 96

Imagery corrections can also be applied using the SIPS 
Template Editor (see “SIPS TEMPLATE WIZARD” ON PAGE 98). 

Revert/Reapply
The most recent correction made in processed mode can be 
undone or redone using the Revert and Reapply tools. 
1. Select the Revert tool to reverse the last correction.

2. Select the Reapply tool to reapply the last correction.

This ability to go back a step without losing your work enables 
you to “toggle” between the before and after of a process. For 
example, with the Signal Display Window open, use Revert/
Reapply to see the effect of slant range correction.

1. 2. 3. 4. 6.5. 7.
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Slant Range Correction
Side scan sonar is initially logged as a series of time-indexed 
intensity values for each ping. Slant range correction re-samples 
this raw side scan data to produce profiles of image pixels where 
the across-track scale is related to distance from nadir instead of 
time.

Across-track positioning 
using height sources

The standard slant range correction operation applies a sound 
velocity estimate to the two-way travel time for each intensity 
value. This produces an estimated ray length that when 
combined with the known sonar height (from the digitized or 
logged bottom) is used to produce the across-track distance to 
the pixel using simple trigonometry. This method presupposes 
that the bottom is flat across the ping and can result in the 
across-track misplacement of objects over varied or steeply 
sloping terrain.
SIPS can use a height source (such as a BASE Surface, grid, or 
tile) in the slant range correction operation to supply depth 
values to improve the across-track positioning of pixels.
In the following figure, raw side scan data is represented as a 
series of time (t) and pixel intensity values (i).

When a height source is used during slant range correction, a 
depth profile is first derived from the source along the path of 
the side scan ping. Then, the two-way travel time to each pixel is 
converted to a distance from nadir using the estimated velocity 
of sound in water. The distance is then used to calculate the 
position of the image pixel along the ping drawn from the height 
source.
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The resulting output is an intensity value indexed to across-
track distance (x) rather than time.

Apply Slant Range Correction
In the Side Scan Editor, Slant Range Correction is applied to 
data in raw mode. Other corrections in Side Scan Editor are 
made to data that has been slant range corrected. Once you 
slant-range correct data, you can return to raw mode to start 
again, however, any correction previously made to processed 
data will be lost.
1. Select the track line(s) in the Display window.

2. Select the Slant Range Correct tool.

The Slant Range Correction dialog box is displayed.
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1. Type the resolution (in metres or feet) for the slant range corrected file. 
The resolution value defaults to the minimum value appropriate to the 
sonar system. If this is not available then it defaults to 0.10 metres or 
0.33 feet. A finer resolution generates a larger file.

2. Enter the average speed of sound.

3. Select the setting for Data Reduction from the drop-down list. 
• The default is to use the 16-bit factor that is stored with the line.
• Select Use 8-Bit Shift if you want to create a slant range file using 

only eight bits of storage per pixel. This option is important if the 
data that you are slant range correcting was originally 16-bit and all 
16 bits were maintained at conversion. 

• Select Use Shift Factor Per Line 

4. Select the Use Height Source check box if you want to apply a height 
source, then select the height source from the list. (This is only 
available if you have a BASE surface or other height source open.)

5. Click Set. The slant range corrected data is displayed in the Side Scan 
Editor.
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Beam Pattern Correction
Beam pattern correction uniformly removes angular artifacts 
from the sonar systems. This effect is produced by each 
transducer uniquely.
Beam pattern correction relies on a user-generated beam 
pattern file to identify and remove this effect. Tools are provided 
to create, view and process beam pattern files. The process uses 
the beam pattern file to uniformly correct the selected line(s), 
producing a more consistent appearance in mosaics.
Once the beam pattern file is created it can be applied to one or 
more lines in the Display window, or to one or more pings in the 
Side Scan Editor.
If no Beam Pattern Correction file exists you will need to create 
one in order to apply Beam Pattern Correction parameters. All 
the tools to create a beam pattern file are on the Beam Pattern 
Toolbar, accessible while the Side Scan Editor is open.

Create Beam Pattern Correction File 
To create a beam pattern file you must select an area that is as 
flat, featureless and homogenous as possible. It is recommended 
that a “patch test” be done during a survey over an area known 
to have such properties. In order to create a more robust and 
accurate beam pattern correction file, it is also important to vary 
the fish height over the range expected to be used during the 
survey.
Beam pattern files can be created from a range of pings or from 
the entire line.
1. Use the Select Side Scan tool to select a homogeneous area in the 

Side Scan Editor window.

2. Select the Create Beam Pattern tool.

The Create Beam Pattern dialog box opens and displays the 
Start and End ping numbers for your selected area.
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You can create a beam pattern file from a range of pings larger 
than the range visible in Side Scan Editor window, by entering 
the start and end ping numbers. However, the pings should be 
from a homogeneous area. 
3. Select Process to create the Beam Pattern file.

The Windows Save As dialog box is displayed.
4. Type a name for the Beam Pattern file and select Save.

The file is saved as a SIPS Beam Pattern File with extension 
*.spb.
You can also create the file from a whole line, but the same 
criteria should be applied.
1. Select a track line.

2. Select the Create Beam Pattern tool.

The Create Beam Pattern dialog box is displayed with the 
Create From Line option selected. 
3. Select Process to create the Beam Pattern file. 

4. Name and save the file.

Adjust Beam Pattern
The Save Beam Pattern, Save Beam Pattern As, View, Remove 
Spikes, Smooth, and Reload tools are now active in the menu 
and on the Beam Pattern Correction toolbar (below). 

View Beam Pattern To see a graph of the beam pattern 
1. Select the View Beam Pattern command.

Create Beam 

Load Beam 

Close Beam 

Save Beam 

Save Beam 

View Beam 

Reload

Set Sediment 
Pattern

Pattern 

Pattern Pattern As

Pattern Pattern Class

Remove Spikes

Smooth Beam 
Pattern

Set Beam 
Pattern Offset 
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The Beam Pattern Graph window is displayed.

Remove Spikes/Smooth The Remove Spikes tool removes anomalies from the Beam 
Pattern Graph.
2. Select the Remove Spikes command.

The next step is to apply the Smooth Beam Pattern tool. The 
Smooth Beam Pattern tool uses a moving average filter to 
reduce noise in the beam pattern. 
An example of the graph before and after using the Smooth tool 
is shown below. The left-hand window shows the unsmoothed 
graph and right-hand window shows the graph after smoothing. 

3. Select the Smooth Beam Pattern tool.

The Smooth Beam Pattern tool can be used repeatedly until the 
preferred degree of smoothing is reached.
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Reload The Reload tool reloads saved changes from the active beam 
pattern file. Any changes to the beam pattern after the last save 
are lost.

 For example, if you remove spikes and then Save, then apply 
Smooth Beam a few times, the Reload tool will restore the graph 
to the point just after you saved it.
4. Select the Reload tool.

Save/Sve As When you have completed smoothing the data, you can save 
these settings using the Save Beam Pattern or Save Beam 
Pattern As… tools.
5. Select Save Beam Pattern to save the filtering and smoothing changes 

to the Beam Pattern File.

6. Select the Save Beam Pattern As command to save the file as a new 
file.

Apply Beam Pattern Correction
The Beam Pattern Correction file can be applied to a selection in 
the Side Scan Editor or to track line(s) in the Display window. 
1. Make a selection in the Editor, or, 

select a track line or group of track lines in the Display window.

2. Select the Beam Pattern Correction command.

The Beam Pattern Correction dialog box is displayed. 

The Beam Pattern file will default to the last file that was 
created, loaded, saved or executed. You can use the Browse 
button to locate a different file for processing. The default 
location for Beam Pattern files is <Data Dir>/Sidescan.
The outer edges of some pings may have been recorded at angles 
beyond the extent of the beam pattern file being used. The Outer 
Edge option must be specified for handling these cases.
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3. Select a method for handling sonar data collected outside the bound of 
the beam pattern file:”
• Extrapolate: Extrapolate the beam pattern to correct angles beyond 

the outer edge of the generated beam pattern file.
• Trim: Remove sonar data that is beyond the extent of the beam 

pattern file. Trimmed data will appear as 0 intensity white space in 
the Side Scan Editor.

• Do Nothing: Does not correct sonar data beyond the extent of the 
beam pattern file. Uncorrected data will appear the same before and 
after Beam Pattern Correction in the Side Scan Editor.

4. Apply the Beam Pattern Correction to the both sides of the side scan or 
to either the starboard or port sides.

5. You can apply the Bean Pattern Correction to your entire survey by 
selecting all the track lines, or you can open the Side Scan Editor and 
select a portion of the data: 
• Ping: the correction will apply to the single ping selected in the SIPS 

Preview window.
• Selection: the correction will apply to the range of pings you 

selected in the SIPS Preview window. 
• Line: the correction will apply to the entire trackline you have 

selected. 

6. Click Process to apply the correction. 
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Angle-Varying Gain
Angle-Varying Gain (AVG) correction removes the angular 
response of sediment from the imagery, normalizing the mean 
angular intensities, ping-by-ping, with a moving average filter. 
AVG correction can be applied to a selection or a single ping in 
the Side Scan Editor or to one or more track lines in the Display 
window. 
1. Make a selection in Side Scan Editor. (See “SELECTION” ON PAGE 62 for 

selecting areas and pings).

2. Select the AVG Correct tool.

The AVG Correct dialog box is displayed.

3. Select the number of adjacent pings to include in the moving average 
by clicking Moving Average Window Size up or down arrow buttons.

For example, an average based on a window size of 100 will 
include 50 pings before and after the ping being corrected.
4. Apply angle-varying gain to the port, starboard, or both sides of the 

side scan.

5. Apply the angle-varying gain correction to either a Ping, Selection, or 
Line by selecting the appropriate option.

6. Click Process.
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Time-Varying Gain
Time-Varying Gain (TVG) Correction allows you to adjust the 
signal intensity by applying a non-uniform, time-dependent 
gain.
During acquisition, this is necessary because of the attenuation 
that occurs due to absorption and spreading as the sonar beam 
travels back to the receiver. Since these returns are received 
over a predictable and constant time period, a time-varying 
curve can used to increase gain in order to compensate for the 
decayed sonar return. In post-production, it maybe necessary to 
augment the TVG correction applied during acquisition.
The TVG Correction command also allows you to apply a 
uniform gain correction without applying the any time-
dependent gains by using only the Gain control.
TVG Correction can be applied to a single ping, selection, or the 
currently selected line in the Side Scan Editor, or to one or more 
track lines in the Display window. 
1. Make a selection in the Side Scan Editor. (See “SELECTION” ON PAGE 62 

for selecting areas and pings).

2. Select the TVG Correct command.

The TVG Correct dialog box is displayed.
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There are two modes for TVG correction: Standard and 
Advanced.
3. Select either the Standard or Advanced mode from the Mode drop-

down list. (The options available depend on the mode selected.)

The TVG dialog box can expand into a Preview window for data 
selected or superselected in the Side Scan Editor window. 
Preview is not available when a track line is selected (the Show 
button is greyed out.)
4. Click Show to view the Preview window. To close the window, click 

Hide.

The Preview window is divided into three panes:
• Gain (shown as a percentage)
• Intensity values before TVG is applied.
• Intensity value after TVG is applied.
Changes are instantaneously shown in the Preview window. 
5. The TVG correction can be made to port, starboard, or both sides by 

selecting the appropriate from the Side drop-down list.

6. The correction can be made to a single ping, a selection, or the entire 
line by selecting any of these options from the Range drop-down list. 
(The options depend on the selection made in the Side Scan Editor or 
in the Display window).

Standard The Standard mode contains two options for correcting TVG.
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7. Increase or decrease the percentage Gain by clicking the up or down 
arrow buttons.

8. Increase or decrease the TVG value by clicking the up or down arrow 
buttons. This changes the TVG curve.

Advanced The Advanced mode contains more precise options for correcting 
TVG.
9. Spherical Spreading compensates for the loss of energy caused by 

signal displacement along the sea floor. Increase or reduce the signal 
intensity by clicking the Spherical Spreading up or down buttons.

10.The Absorption value compensates for attenuation due to energy loss in 
water. The scale factor is in dB/unit distances. Click the up or down 
arrow buttons to increase or reduce this value.

11.Click Process to apply the TVG correction.
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Despeckle
Despeckling uses a calculated value based on neighbouring 
intensity levels to replace the current pixel’s intensity if it is 
outside the specified range. The value calculated from the 
neighbouring intensities can be derived by one of two methods 
mean or median.
Despeckling imagery is a visual process, consisting of adjusting 
the despeckle values and viewing the display until the desired 
results are obtained. 
The following steps are used for despeckling images:
1. Select a track line.

2. Select the Despeckle tool.

The Despeckle dialog box is displayed. 

3. Select the Mean or Median Filter from the Method drop-down list.

4. Use the up and down arrows to select a Threshold for defining an 
acceptable range in which the pixel value will not be replaced. 

For example, if the mean value is 50 and the threshold is +/- 20% 
then the acceptable range is 40 to 60. Thus a pixel value of 38 
would be replaced by the mean value of 50 as it is outside the 
range, but a pixel value of 42 would not be replaced. 
5. Select a pattern of neighbouring pixels from the Matrix Size drop down 

list be used in calculating the mean/median.

6. Click Process

The line is filtered to remove noise from the sonar image.
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Contacts
A Contact is the representation of an object or feature on the sea 
bottom (for example, a wreck, or a pipeline) that is visible in the 
sonar data. Contacts can be georeferenced, have positions 
calculated, and have attributes attached to them in the Side 
Scan Editor using the Add Point or Add Line Contacts tools.
In SIPS, you can place individual contacts directly in the 
waterfall view. A contact record is created for each contact, and 
includes sufficient information to be subsequently exported to a 
CARIS map or to a database application. (
A contact file is created for each survey line and is stored in the 
line folder within the project directory structure. Each contact 
file is a text file that can be viewed and edited using a text 
editor. Each file consists of zero or more contact records.
Contact information can be exported. (This is described in 
Export “CONTACTS” ON PAGE 491 of the User Guide.)

Create Contacts
Point type contacts can be created for objects such as rocks, 
underwater posts or pile as well as wrecks. Contacts can also be 
created for continuous objects such as pipelines or underwater 
cables.
Contact information is entered on the General tab of the Control 
window and updated on the Contact Details tab. 
1. Make sure the Control window is open and the General tab in the Side 

Scan Section is displayed.

2. Enter information in the appropriate fields on the General tab.
• Contact Type: Select a point or line contact type from the 

appropriate drop-down list. Each contact type is assigned a CARIS 
feature code, and there is an identifying symbol for each type. The 
contact types shown in the lists and the corresponding CARIS 
feature codes are stored in …\Hips\system\ContactFeature.txt.

• User Initials: Type a maximum of three characters to identify the 
creator of the contact. The initials are used in the editor as part of a 
contact identifier.

• Prefix: The prefix is usually the line number. It is combined with the 
contact number to generate a 12-character key for database 
applications.

• Image Width: (optional) Enter a width for any image file created from 
the contact.

• Image Length: (optional) Enter a length for any image file created 
from the contact.
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• Display with single colour: Select this to have all contact markers 
and their identifiers appear in the same default colour. (The default 
colour can be set in Side Scan Editor Display Options on the Tools 
menu.) Leave blank to have a one colour apply to the contact 
markers and a different colour applied to the bounding box and 
contact labels. 

Point Contact

3. To insert a point contact, select the Add Point Contact tool and click 
where you want to place the contact.

A contact marker is placed in the Side Scan Editor at the point 
where you clicked. 
The type of contact is indicated by the symbol displayed. The 
contact is identified by the initials entered in the General tab, 
and a four-digit number (starting at 0001). The information 
entered in the General tab is assigned to the contact.

The image bounding box always snaps to the contact so that the 
contact point is in the middle of the box. The bounding box 
represents the image area of the contact. You can adjust the size 
of the image using the Image Width and Image Length fields on the 
Contract Details tab in the Control window. 

Line Contact

To insert a contact record for a line:
1. Select the Add Line Contact tool and click the point where you want to 

insert the contact.

2. Click another section of the Side Scan Editor.

The two points are joined by a line.
3. Continue adding line segments as needed to represent the contact. 

4. Select Edit Line> Remove last to delete the line segment just created.
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5. To escape the Line Contact tool, right-click the mouse and select Edit 
Line> End from the pop-up menu.

The contact lines are drawn in the Side Scan Editor. Each line is 
identified with a number, and each type of line is drawn in a 
different style. The information entered in the General tab is 
applied to the contact. The contact is identified with the initials 
entered in the General tab, along with a four-digit number 
(starting at 0001).

Repeat New Feature When the Repeat New Feature tool is activated, you can add any 
number of contacts of the same type and attributes, without 
having to set each one separately. 
To add multiple similar contacts:
1. Select the Repeat New Feature command. 

2. Enter contact information in the appropriate fields on the General tab in 
the Control window.

3. Use the Add Point Contact tool to place the contacts, one after the 
other, into the Side Scan Editor.

The Repeat New Feature tool button will remain depressed 
while you add contacts. To change to a different type of contact 
or to change contact data, deactivate the Repeat New Feature.

Editing Contacts
You can reposition both line and point contacts and update the 
data associated with a contact.
The Select Contact tool is used to select point or line contact(s) 
for editing. 
1. To select a single contact, click on or draw a box around the contact so 

that it becomes highlighted. Clicking on any part of a line will select the 
entire contact.

2. To select a number of contacts, press the mouse button and drag the 
cursor across an area so that the contacts within it are highlighted.

Move Contact 1. To move a selected contact, select the Move Contact tool.

2. Position the cursor on top of the selected contact. Press and hold the 
mouse button. This will turn the highlighted contact into a red box with 
direction arrows.

3. Drag the contact to a new position.

4. Deactivate the Move Contact tool to finalize the new position of this 
contact. You are returned to the Select Contact tool.

You can use the Move Contact tool to move an entire line 
contact, or to adjust or realign part of the line. 
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5. To move a selected line contact, position the cursor on any part of the 
line, press and hold the mouse button, and drag the whole line to a new 
position.

6. To realign part of a selected line, click on the line. This will highlight 
nodes which will appear as squares on the line. 

7. Click on the node to be adjusted, which will turn the node square red. 
Position the cursor on the node. Press and hold the mouse button, and 
drag it to a new position. This will pull the attached lines with it.

Changing Contact 
Information

You can change the information that is associated with the 
contact when it was first created, either by typing it in or with 
measurement tools.
1. Choose the Select Contact tool.

2. Select a single contact.

The contact is highlighted and the contact information is 
displayed in Contact Details tab in the Control window.
3. Type new information in the fields and/or select a new object type from 

the drop-down list.

4. Click Update.

Use the Measure Distance and Measure Shadow tools on the 
Side Scan Editor toolbar to amend the contact information.

Use Measure tools 5. To update the contact width information, choose the Measure Distance 
tool and press and hold <Ctrl> while dragging the cursor across the 
area of the contact to be measured.

If measuring in the SIPS Preview window, the value in the 
Contact Width field will reflect the measurement as you are 
making it. If measuring in the Zoom tool, the value will be 
updated when the mouse button is released.
6. To retain the updated information, release the mouse button and then 

the <Ctrl> key.

7. To update the Contact Length information, choose the Measure 
Distance tool and press <Alt> while dragging the cursor across the 
contact area.

8. To update the Contact Height field, select the Measure Shadow tool 
and press <Ctrl> while dragging the cursor across the contact area.

9. Click Update. If you do not click Update, the values will be lost when 
the contact is de-selected.

The contact information is updated.

Purge rejected contacts To delete a rejected contact from the data file.
1. Use the Select Contact tool to select the rejected contact.

2. Select a Purge Rejected Contacts command.

The rejected contact is deleted.

M
en

u Tools > Side Scan 
Editor > Measure 
Distance

To
ol

M
en

u Tools > Side Scan 
Editor > Measure 
Shadow

To
ol

M
en

u

Tools > Side Scan 
Editor > Contacts > 
Purge Rejected 
Contacts

To
ol



CARIS HIPS and SIPS Editors 97

Side Scan Editor: Contacts

Recompute Contact Positions
Update the geographic positions of contacts after towfish 
navigation has been recomputed for a track line or group of track 
lines.
1. Select the ship or towfish track lines layer in the Layers tab of the 

Control window.

2. Select one or more track lines.

3. Select the Recompute Contact Position command.

Position information for contacts along the selected track lines 
are updated to match the new towfish navigation.
The start time, end time and elapsed time for the recompute 
process is reported in the Output window. Any error in the 
processing will be reported there also. 

View contacts while 
scrolling

If you want your contacts to remain visible in the waterfall 
display while scrolling along a track line or using the Playback 
functions
1. Select Side Scan Editor from the Tools > Options > Display tab. 

2. Select the Display contacts during playback check box, and click Apply. 
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SIPS Template Wizard
In the SIPS Template Wizard you can set options for imagery 
correction into a single flow and saved the settings in a template 
file to be consistently applied to data. 
The Wizard can be run from Side Scan Editor to apply any or all 
of: 
• Slant Range Correction
• Beam Pattern Correction
• AVG Correction
• TVG Correction
• Despeckle
as well as creating GeoBars to be used in mosaics.
The SIPS Template Wizard and its processes are described 
in“USING SIPS TEMPLATE WIZARD” ON PAGE 441 in the PROCESS IMAGERY DATA 
section of the Users Guide.



6
 Process Single Beam Data

The Single Beam Editor contains data cleaning tools for data converted to 
HIPS from single beam echo sounding surveys. The Data can be cleaned 
both interactively and with filters, and the display of data can be scaled 
horizontally and vertically, and sounding depths can be adjusted.

In this chapter...
SINGLE BEAM WORKFLOW........................................... 100
SINGLE BEAM EDITOR INTERFACE................................. 101
PRIMARY AND SECONDARY DATA.................................. 109
CHANGE SOUNDING DEPTHS........................................ 110
SINGLE BEAM CLEANING ............................................. 112
AUTO-CURSOR MODE ................................................ 113
SINGLE BEAM FILTERING............................................. 114
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Single Beam Workflow
Processing of Single Beam data follows a similar workflow to 
that of multibeam, from creation of projects to merging of data to 
creating a BASE surface or a tile surface to select soundings or 
add contours. 
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Single Beam Editor Interface 
To open the Single Beam Editor:
1. Select a survey line in the Display window.

2. Select the Single Beam Editor command.

The Single Beam Editor is opened in the HIPS interface.

The Single Beam Editor window is located (by default) below the 
Display window. The editor can be un-docked and moved to 
another location like other windows in HIPS.
The display and events options are controlled from the Single 
Beam Editor tab in the Control window.
The soundings are shown in the editor as dots connected by 
lines. You can set the horizontal scale to represent distance or 
time. Distances are derived from the navigation data. The first 
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sounding with an associated position is considered the start of 
the line. All subsequent distances are computed from this point 
using sounding positions interpolated from navigation data. 
When the horizontal scale is by time, the sounding timestamps 
are used.
You can move up or down the track line by clicking the scroll bar 
or turning the mouse wheel (if available).

Toolbar The Single Beam toolbar is automatically 
displayed when the editor is opened. This toolbar 
is used for selecting primary or secondary data as 
Selected data (see “PRIMARY AND SECONDARY DATA” ON 
PAGE 109). The toolbar can moved and docked in the 
interface like other toolbars (see “DISPLAY TOOLBARS” ON PAGE 31).
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Single Beam Editor tab
The Single Beam Editor tab in the Control window contains four 
tabbed pages:
• “GENERAL TAB” ON PAGE 104

• “EVENTS TAB” ON PAGE 105

• “BARCHECK TAB” ON PAGE 107

• “TRACE TAB” ON PAGE 108
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General tab
Change horizontal scale The range of data that is visible along the horizontal scale can 

controlled by distance or time. As you increase these values more 
data is displayed in the editor.
This provides a scaling method that simulates the echo sounder 
paper speed controls so that the digital profiles can resemble the 
analogue records.
1. In the General tab, select either the By Time or By Distance option.

2. Select a range of data using the Horizontal Scale arrow buttons.

Adjust vertical scale The vertical scale displays the distance values. The Auto setting 
uses the maximum and minimum soundings in the current view 
to set the depth values for that view. As you move along the 
track line, the depth values change to accommodate the visible 
sounding data.
You can set a scale as a ratio of the vertical scale to the 
horizontal scale. As the ratio is increased, the vertical display of 
data becomes more exaggerated.
To set a vertical scale:
1. Clear the Auto check box.

2. Click the Vertical Scale arrow buttons to select an appropriate scale.

The display in the Single Beam Editor View is refreshed to 
accommodate the selected scale.

Adjust horizontal labels The horizontal labels show the depth or time values at regular 
intervals along the survey line. The Auto selection spaces the 
labels far enough apart so you can see them clearly. You can 
determine the spacing you want for the labels.
1. Clear the Auto check box in the Horizontal Labels section.

2. Click the arrow buttons to select a new scale for the labels. If you select 
By Distance for the horizontal scale, then the labels are displayed as 
metres/feet. If you select By Time, the labels are displayed hours/
minutes/seconds/fractions of a second.

The display in the Single Beam Editor is refreshed to show the 
labels according to the selected settings

Display Data The Data options set which data is displayed. The default is to 
show all the data types. 
1. Use the check boxes to toggle the display of data on and off.

• Primary: displays primary data
• Secondary: displays secondary data
• Join Points: connects the sounding points with a line. 
• Selected: displays the Selected frequency when dealing with Dual 

frequency data.
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The display colours of the Primary, Secondary and Selected data 
are set in Tools > Options > Display > Single Beam.

View moving average 
data

You can see the moving average data in the Single Beam Editor 
by selecting any of the following check boxes in the Single Beam 
Editor tab in the Control window. For more information on 
applying Moving Average filtering to single beam data, see 
“SINGLE BEAM CLEANING” ON PAGE 258 in the Users Guide.
• Data graphs the raw sounding data. This box is checked by 

default.
• Moving Average graphs the computed moving average from the 

adjacent data points as described above.
• Difference graphs the difference between the original data 

values and the moving average for each data point.
• Thresholds displays horizontal lines in the graph indicating the 

difference values that are rejected during filtering. Threshold 
is a multiple of the standard deviation (sigma).

Events tab
Event marks are commonly generated by the logging system at 
periodic intervals. Each event mark contains a unique identifier 
and time stamp. These event marks are displayed in table 
format on the Events page.
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To display the event marks in the Single Beam Editor window: 
1. Select the Show Event Marks check box.

The event marks are displayed at the top of the window.
 

To centre the data in the Single Beam window on a specific event 
mark:
2. Double click on the event mark in the table. 

The display will shift so that the data display in the editor 
window is centred on the selected event mark. 

Event mark

Points joined 
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Barcheck tab
If there is barcheck data available, it can be used to generate a 
Sound Velocity Profile (SVP) file based on a list of measured 
depths against a list of actual depths. The Barcheck tab displays 
barcheck values and is used to add barcheck values.
 

To add barcheck values:
1. Select soundings in the Single Beam Editor window.

2. Select Add to Barcheck command.

The Add to Barcheck dialog box is displayed. 
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The Measured Depth field displays the depth that was recorded by 
the sounder. If more than one sounding is selected, then a mean 
is calculated from the selected soundings.
3. Enter a new depth values from the barcheck data in the Actual Depth 

field. 

4. Click Add.

The depth values and the sound velocity for the coordinates are 
now displayed in the Barcheck tab.
5. Repeat these steps as needed.

6. To delete a set of values from the table, highlight it and click Remove.

7. Click Save.

The Save dialog box is displayed. The default location for the file 
is ..\HIPS\SVP.
8. Type a name for the file and click Save.

Trace tab
HYPACK data can contain a bin file that contains an image of 
the single beam trace. If this data is available the Show Trace 
option is activated. Setting this option will display the trace 
image as background in Single Beam Editor.
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Primary and Secondary Data
Dual frequency data can be imported through the Generic Data 
Parser, the Hypack converter and the Winfrog converter.
These frequencies (and the associated data) are designated as 
Primary or Secondary. By default, all Primary frequency data is 
designated as the Selected Frequency, and processed further in 
HIPS and other CARIS products.

Show/Hide data 1. Make sure the Single Beam Editor tab in the Control window is 
displayed.

2. Select or de-select the following check boxes to show or hide data. 
When the box is checked, the sounding data associated with that 
frequency is visible in the editor.
• Primary
• Secondary
• Selected

The Single Beam Editor is refreshed to show the selected 
frequencies.

Select Primary/
Secondary data 

Although Primary data is automatically designated as the 
Selected frequency, you can set the Secondary depths as 
Selected, and toggle between Primary and Secondary to view 
data. (The two frequencies cannot be averaged.)
1. In the General tab, select the Primary and Secondary check boxes so 

that all the frequency data is visible in the editor.

2. In the editor window, press and hold the mouse button and drag the 
cursor to highlight both the Primary and Secondary data.

The Select Primary and Select Secondary buttons are activated.
3. Select a Primary or Secondary command.

The highlighted Primary or Secondary data is now marked as 
Selected.
To see which frequency has been set as Selected, toggle the 
check boxes in the Data section of the General tab on and off.
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Change Sounding Depths 
The Single Beam Editor lets you modify the digital depths 
created by the echo sounder's digitizer. Sometimes when fish or 
other obstructions in the water column trigger the digitizer, the 
sea bottom may still be visibly detectable on the analog sounding 
graph. This function lets you set the echo sounder’s depth values 
to the analog sounding depth values.

Change Depths
1. Set the Selected check box in the Data fields of the SingleBeam Editor 

General tab, if needed.

2. Select a sounding(s) in the Single Beam Editor window. 

3. Select the Change Depths command.

The Change Depths dialog box is displayed.

To move the sounding to a specific depth: 
4. type the new depth in the Depth Value field, and

5. select the Absolute option.

To move the sounding by a set amount:
6. Type the amount by which to move the sounding.

To move the sounding to a deeper depth level, enter a positive 
value (for example, 5.5). To move the sounding to a shallower depth 
level, enter a negative value (for example, -5.5).

7. Select the Offset option. 

8. Click Preview to view the sounding at the new level.

9. Click Apply to set the sounding at the new depth and close the dialog 
box.

You can also change depth values directly in the editor. 
However, this option omits the preview function of the dialog 
box.)
1. Select soundings.
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When the mouse is positioned over the selected data, the cursor 
becomes a two-headed arrow with a Z symbol beside it.
2. Press and hold the mouse button, and drag the cursor either up or 

down.

The highlighted soundings move with the cursor.
3. Release the mouse button when the soundings are at the new depth.

4. To cancel the effect of moving these soundings to the new depths, 
select Undo from the Edit menu.

Add Depths
Add a new sounding by supplying time and depth. The position 
of the new sounding is interpolated from the existing navigation 
data (using the supplied time). A quality code can also be 
entered. If you enter a new depth, a new observed depths file 
and a new slant range (travel time) file is generated.
You can add depths by selecting an existing sounding and 
inserting a new depth or by creating a new time stamp without 
selecting an existing sounding.
1. Select the Add Depths command.

The Add Depths dialog box is displayed.

2. Select the Time field and type a new timestamp value.

3. Select the Depth field and type a new depth value.

4. Select a new quality flag, if needed.

5. Press OK to add the new depth value to the file.
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Single Beam Cleaning
Sounding data can rejected interactively or by applying the 
single beam filters (see “SINGLE BEAM FILTERING” ON PAGE 114). 
This section covers how to interactively reject, accept and query 
data in the Single Beam Editor. These processes are similar to 
the Swath Editor.

Reject Data
Each sounding carries several status flag switches that are 
turned on and off as needed. Each sounding begins with 
Accepted status. If rejected for any reason during processing it 
can be returned to Accepted status without loss of data.
A sounding rejected within the Single Beam Editor has the 
Rejected by Swath Editor flag turned on (the same status flag is 
used for both swath and single beam data).
To reject a sounding, 
1. Select the data to be rejected so it is highlighted.

2. Select the Reject command.

The Rejected by Swath Editor status flag is now on and the 
sounding may or may not be displayed depending if the rejected 
data is visible.
You can show or hide rejected data. When the rejected data is 
turned off, these soundings are no longer visible in the Single 
Beam Editor.
1. Select the Show Rejected command.

Accept Data
Change Rejected soundings back to Accepted status.
1. Select the rejected data so it is highlighted.

2. Select the Accept command.

The soundings are now flagged as Accepted.

Query Data
View data on selected soundings.
1. Select the data to be queried.

2. Select the Query command.
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The following data is displayed in the Selection tab. The data is 
colour-coded depending on whether it is Primary, Secondary or 
Selected frequency data. 
• Record
• Type (primary, secondary, or selected)
• Timestamp
• d-Time
• Approximate Position
• Distance
• d-Distance
• Depth
• d-Depth
• Status

Change sounding status Once data information is displayed, you can change the status of 
the sounding.
1. Select the sounding data in the Worksheet window.

2. Select Accept or Reject.

The changed status will be displayed in the Selection tab. 

Auto-Cursor Mode
The auto cursor combines the select and Accept/Reject and 
Query functions into a single procedure. The function is 
available in the HIPS and SIPS Editors.
1. Select the Auto Cursor command.

2. Select an Accept or Reject command, or select Query.

The cursor changes shape to reflect the command you have 
chosen: a “ ” for Accept, an “X” for Reject and a “Q” for Query.
3. Press and hold the mouse button and drag the cursor over data in the 

Editor window so that the data is highlighted.

4. Release the mouse button.

The highlighted data will be Accepted or Rejected. If you chose 
the Query command, the highlighted data will be displayed in 
the Selection tab. 
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Single Beam Filtering
Using the Single Beam Editor you can filter single beam data 
converted from single and dual frequency echo sounders. This 
tool inherits some of the functions of the Swath Editor such as 
vertical exaggeration and filtering functions. 
When dealing with bathymetric datasets, it is advantageous to 
reject outliers automatically. To do this, the Single Beam Editor 
has a set of filters.
The parameters for these filters are set through the Set Filters 
dialog box, and saved in a HIPS Filter File (.hff) that can be 
reopened for use in another track line.
1. Select a track line.

2. Select the Set Filters command.

The Set Filters — Single Beam tab of the Set Filters dialog box 
is displayed.

3. Make sure the Single Beam tab is displayed.

4. [Optional] Select an existing HIPS Filter File from the list or click 
Browse to select a file.
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If you chose to load a filter file, all values in that file are shown 
in the fields. You can go to Step 7 or change any of the values.
5. Select either a Reject or Accept logic command to apply to the filtered 

data.

6. Select the Include Filter check box to activate the filtering options.

7. Select from three filtering options:
• Moving Average (see “MOVING AVERAGE FILTER” ON PAGE 115)
• Depth (see “DEPTH” ON PAGE 116)
• Beam-to-beam slopes (see “BEAM-TO-BEAM SLOPES” ON PAGE 116)

You can define and apply more than one filter test. The filters 
are applied in sequence. Any data rejected by one filter is not 
considered in the next filter test.
8. Select the frequency to apply to the filters by making sure the 

appropriate box is checked.

9. Click Close, or click Clear to remove data from the fields.

Click Save As to save the settings to a filter file.

Moving Average Filter
The Moving Average Filter rejects (or accepts) data with 
difference values that fall outside of defined threshold limits. To 
view the Moving Average filtering options in the Single Beam 
Editor, see “GENERAL TAB” ON PAGE 104.
A moving average is calculated for each sounding (data point) by 
using the adjacent soundings. The amount of adjacent data is 
specified either as the number of points or as a time period.
1. Select the Moving Average check box to enable the associated fields.

Set the moving average 
using seconds 

This option uses a time range (in seconds) to calculate a mean 
average for each data point.
For example, if you select 10 seconds as the moving average, the 
filter calculates a mean average for any data point using itself 
and any data points in the five-second range either side of it.

Setting the moving 
average using points

This option uses a range of adjacent data points to calculate a 
mean average for each data point.
For example, if the moving average is set to five data points. A 
mean for any data point is calculated using itself and the two 
data points on either side of it (if available).
2. Select how you want the moving average to be calculated by selecting 

either Points or Seconds.

3. Use the arrow buttons to select the number of seconds or data points.

A difference value for each sounding is calculated for each 
sounding from the adjacent soundings.
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Thresholds The thresholds indicate what difference values are rejected (or 
accepted) during filtering. 
The upper threshold is determined by the following formula:

original mean value + (threshold value X the 
standard deviation)

The lower threshold is determined by the following formula:
original mean value – (threshold value X the 
standard deviation)

Select a threshold value by clicking the arrow buttons.

Depth
1. Enter the depth values for filtering soundings. There are two options:

• Minimum Depth: Reject (or accept) any soundings that are 
shallower than the depth specified (e.g., 10 m).

• Maximum Depth: Reject (or accept) any soundings that are deeper 
than the depth specified (e.g., 50 m).

Beam-to-Beam Slopes
For each sounding, calculate the slopes, in degrees, to the 
previous and next soundings. If both slopes exceed the defined 
value and are of opposite sign, then reject the sounding.
1. Enter the degree value for the slope.

2. Select the Include Rejected option to include previously rejected 
soundings when recalculating the slopes during multiple runs of the 
filter.

Apply Filters
The last step is applying the automatic depth filter to the data.
1. Select a Filter command to apply the criteria set by the Set Filters 

dialog box.

You have four options for applying the filters.
Filter 1 Screen. Apply the filters only to the soundings that are 
currently visible in the Single Beam Editor. 
To End of Line. Apply the filters to the track line currently open 
in the Single Beam Editor, from the first sounding currently 
visible in the editor to the end of the line. 
Selected Lines. Apply the filters to all of the currently selected 
track lines. This function does not require that the editor be 
open. 
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All Lines. Apply the filters to all track lines currently open in the 
Display window. This function does not require that the editor 
be open.
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7
Subset Editor

Subset Editor is a tool for viewing and editing geo-referenced sounding 
data. 

In this chapter...
SUBSET EDITOR INTERFACE......................................... 121
SIZE AND RESIZE SUBSET ........................................... 123
SUBSET EDITOR TAB .................................................. 125
SUBSET 2D VIEW ...................................................... 128
SUBSET 3D VIEW ...................................................... 132
MEASURE DISTANCE................................................... 135
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Overview
Subset Editor differs from Swath Editor in that soundings no 
longer have only an across-track and along-track relationship—
but after correction for navigation, vessel heading and other 
auxiliary sensors, each sounding has a latitude and longitude 
value attached to it.
With Subset Editor you can:
• view data in a three-dimensional mode so features such as 

depressions and rises are visible.
• rotate data to view it from different angles.
• view BASE Surface areas in the 3-D window.
• view and edit CUBE surfaces, using subset tiles to track the 

areas that have been completed.
• flag soundings as needed to status of:

• rejected
• accepted
• outstanding
• examined
• designated.

• view water column imagery (see “WCI DATA IN SUBSET EDITOR” ON 
PAGE 460.)

“SUBSET CLEANING” ON PAGE 315

“DESIGNATE SOUNDINGS” ON PAGE 318

“HYPOTHESIS EDITING” ON PAGE 241 in the HIPS and SIPS Users Guide.
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Subset Editor Interface

Open Subset Editor
Track lines should be Merged before Subset Editor is opened. 
1. Select the Subset Editor command.

The cursor changes shape.
2. Press and hold the mouse button, and drag the cursor across the area 

of the Display window where you want to create the subset.

As the cursor is dragged across the Display window, a bounding 
box is drawn to show the subset area. 

Subset bounding box

3. Select the Load Subset command. 

The subset is generated and displayed in the Subset Editor 
windows. Below is an example of HIPS and SIPS with the 
Subset Editor open.
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The Subset Editor has the following components:
• Subset bounding box: The bounding box defines the area 

where the subset is generated. Each time the box is moved or 
resized, a new subset is generated. The yellow 2D slice box 
defines the area to appear in the 2D window.

• The 3D View: The 3D (three-dimensional) View shows all 
soundings in the subset area. The view in the window can be 
rotated or changed. 

• The 2D View: The 2D (two-dimensional) View displays 
soundings from the subset area that are within the 2D slicing 
box. 
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Toolbar
Subset Editor commands can be activated from the toolbar. This 
floating toolbar is automatically opened when the editor is 
started. (If it is not visible when Subset Editor is opened, the 
View > Toolbars > Subset Editor command can restore it.) 
The toolbar can moved and docked like other toolbars .
 

Size and Resize Subset
The size of the subset is determined by the bounding box. As the 
bounding box area is changed, a new subset is generated and the 
displays in the 2-D and 3-D Views are refreshed to show the new 
area.
Below is an example of the subset bounding box.

To resize the subset areas:
1. Position the cursor over any of the balls at the corners of the boxes.

2. Press and hold the mouse button and drag the ball. 

3. As the ball moves with the cursor, the box is resized to a new area.

You can also move the 2-D Subset slice up or down in the 
bounding box by pressing the arrow keys. The arrow at the top of 

Show 2D 
Complete

Incomplete

Partly Complete

Clear

Show 3D 

Nominate

Reject
AcceptView

View

Reject Node

Accept Node

Load Subset

Lock

The 2D slice box 
determines the area that 
is displayed in the 2D 

Subset View.

The 3D bounding box 
determines the subset 
area. The area inside 
this box is displayed in 
the 3D View.

The arrow helps maintain 
a sense of direction 
when the subset is 
rotated.
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the box shows the direction of the 2-D slice when the up arrow 
key is pressed.
When the box is resized, a new subset is generated.
To rotate the subset:
1. Press and hold the <Ctrl> key.

2. Position the cursor over any of the corner balls of the box.

Press and hold the mouse button to rotate the bounding box to 
the desired angle.

Auto load subset The Auto Load Subset option automatically loads subset data in the 
3-D and 2-D Views when a subset area is created or changed. 
1. In the Subset Editor tab, select the Auto Load Subset check box to turn 

this option on.

The Lock option locks the subset area so you do not accidentally 
resize or move the subset while moving it in the Display window. 
A new subset cannot be created while the lock is active.
1. Select the Lock command after creating a new subset or resizing a 

existing one.

The subset area is now locked into place and cannot be adjusted 
until the lock is removed.
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Subset Editor Tab
Subset Editor tab is opened in the Control window when the 
Editor is started. The tab controls the data properties for the 
data layers in the Editor. The image below shows the properties 
for the HIPS Data layer.

The top part of the tab displays the different data layers that can 
be viewed in Subset Editor. When you select one of these layers, 
the bottom part of the tab is refreshed to display the controls for 
the data properties for that layer. 
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The check boxes beside the layers control the display of data in 
the 3D and 2D Views. When the check boxes are selected and the 
layers are highlighted, data associated with that layer are 
shown in the 3D Display. When the check boxes are cleared, the 
data is no longer displayed.
The following layers are listed in the Subset Editor tab:
• HIPS Data: This layer controls the properties for sounding 

selection and display. The 3D and 2D sub-layers control the 
display in their respective views.
For information on the controls related to these layers, see 
the following sections:
• “VIEW SUBSET INFORMATION” ON PAGE 126.
• “COLOUR OPTIONS” ON PAGE 127

• “SUBSET 2D VIEW” ON PAGE 128

• “SUBSET 3D VIEW” ON PAGE 132

• Reference Surface: This layer controls the properties related 
to the display of BASE Surfaces in the 3D View of Subset 
Editor. For more information related to this layer, see the 
following section:
• “SUBSETS AND BASE SURFACES” ON PAGE 326 in the HIPS and SIPS 

7.1 Service Pack 2.
• CUBE Hypothesis: This layer controls the display and editing 

properties related to CUBE data. For more information 
related to this layer, see the following section:
• HYPOTHESIS EDITING ON PAGE 241 OF THE HIPS AND SIPS USER GUIDE.

• Tracking: This layer controls the properties for subset tiles. 
For more information on the controls related to this layer, see 
the following section:
• TRACKING CLEANING STATUS ON PAGE 325 OF THE HIPS AND SIPS USER 

GUIDE

View Subset Information
Each time a subset is generated, the following information is 
shown in the middle section of the Subset Editor tab:
• total soundings in the current subset
• total memory used by subset
• total accepted soundings
• total rejected soundings
• width
• height
• minimum depth level
• maximum depth level
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Colour Options
You can control how soundings are displayed in the subset.
1. Make sure the Control window is open.

2. In the Properties > Colours section of the Subset Editor tab, open the 
drop-down list in the Attribute field.

3. Select one of the following attributes from the drop-down list to colour-
code soundings:
• Depth: The recorded depth level of the soundings.
• Amplitude: Backscatter intensity values.
• Depth Uncertainty: The vertical uncertainty values accorded to 

soundings.
• Position Uncertainty: The horizontal uncertainty values accorded 

to soundings.
• IHO S-44: The S-44 Survey Order ranking applied to soundings.
• IHO S-57: The S-57 Zones of Confidence (CATZOC) attributes 

ranking applied to soundings.
• Project: The project where the data was saved.
• Vessel: The vessel(s) used on the survey.
• Day: The day the sounding data was recorded.
• Line: The track line in the project.
• Amplitude: The sonar’s wave pattern.
• Detection Method: The phase detection method.

Colour Map You can represent a range of values using a colour map. The 
colour ranges can be applied to other subsets so you have a 
standard colour code for displaying data. 
• The colour at the top end of the selected map represents the 

minimum value (and all values less than the minimum 
value). 

• The colour at the bottom of the map represents maximum 
value (and all values greater than the maximum value).

• The colours in between the minimum and maximum colours 
represent the depths and uncertainties between the defined 
range.

4. To set a minimum and maximum values, select these two check boxes 
and type the values in the respective fields. If these values are not set, 
then they are automatically read from the subset.

5. [Optional] Select the Reverse Colours check box to reverse the order in 
the colour map.    

The display in the Views is refreshed to show the subset in the 
selected colours.



128 CARIS HIPS and SIPS Editors

Subset Editor: Subset Editor Tab

Subset 2D View
The 2D View displays a profile of soundings within the 2D 
slicing box. You can use this view to examine and clean data.
The location and size of this cutaway view is determined by the 
size of the 2D slice box (see “SIZE AND RESIZE SUBSET” ON PAGE 123). As 
the slice box is re-sized or moved to another position in the 
subset, the display in the 2DView changes accordingly.
1. Select the 2D View command to display data in the 2D View window.

The 2D View is displayed. The example below displays depth 
data in the 2D View with the graticule (grid) option turned on. 

All controls for the 2D View are in Subset Editor tab.
2. In the Subset Editor tab, expand the HIPS Data layer and select the 2D 

View sub-layer.

The Properties for the 2D View are shown. 
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Change view 
perspective

When the 2D View is first displayed, the view perspective is 
determined by the setting in the View direction drop-down list. The 
setting options are:
• Right: view data from the right side of the slice box
• Top: view data from the upper side of the slice box
• Left: view data from the left side of the slice box
• Bottom: view data from the lower edge of the slice box
• Plan: view data looking down into the box from above
• Automatic: the perspective is determined by the dimensions 

of the 2D Slice Box.
• If the height of the slice box is greater than the width, the 

view is automatically shown from the Left side.
• If the width of the slice box is greater than the height, the 

view is automatically shown from the Bottom.
 

2D Slice

3D outline

Left side

Left side Bottom

2D Slice

Bottom

Plan view
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2D vertical exaggeration The vertical exaggeration is the ratio of the vertical scale versus 
the horizontal scale. You can set the vertical exaggeration with 
the vertical exaggeration scale in the 2D View.

As you move the ball, the data in the 2D View is rescaled.
The Auto Exaggeration option determines the scale automatically by 
using all visible depths.
When Auto Exaggeration mode is on, the Include Rejected option 
controls whether or not the rejected data is used to determine 
the minimum and maximum sounding depth to be displayed in 
the 2D View.
4. Select the Auto Exaggeration check box.

5. Select the Include Rejected option to resize the display in the view to 
include rejected data.

The 2D View is adjusted to display data according to the 
maximum and minimum settings.

Display options The display can also be modified to draw sounding values in the 
View and display a grid with depth and distance values.
1. Select the Show Sounding Digits check box to draw sounding values in 

the View.

Values representing distance and depth are displayed along the axes. The 
vertical scale represents depth and the horizontal scale represents 
distance from the lower left corner of the slice. 

To show a grid of these values: 

2. Select the Show Graticule check box.

Values shown in the 2D View are determined by the View 
Direction option:

• If the Right/Top/Left/Bottom options are selected, both the depth 
and distance are shown.

• If the Plan option is selected, distance in both directions is 
displayed.

Properties At the bottom of the list of options the following properties of the 
2D slice is displayed:
• number of soundings in the 2D slice

1. Position the cursor over the ball on the vertical 
exaggeration scale.

2. Press and hold the mouse button, and move the ball up 
or down the scale.

3. To change scale values, click the arrows at the ends of 
the scale to increase or decrease the scale by a value 
of 10.



CARIS HIPS and SIPS Editors 131

Subset Editor: Subset Editor Tab

• dimensions of the slice (height x width)
When the 2D slice bounding box is resized, the information in 
the tab is refreshed with new data.

Move 2-D Display You can move the 2-D Slice box within the subset with the arrow 
keys.

1. Press the arrow keys to move the 2-D Slice Box within the subset.

2. Select an Overlap Percent to determine how much of the 2-D Slice box 
overlaps the previous area in the 2-D View when the box is moved. 
(The higher the percentage is, the larger the amount of overlap and the 
greater the number of slice views within the subset.)

Pan and zoom options The pan and zoom functions are the same as in the 3D View in 
the Swath Editor. See “PAN AND ZOOM” ON PAGE 166 for more 
information.
You can also pan in the Views by clicking on a sounding with the 
middle-mouse button. This will shift the subset so that the 
sounding is centred in the View.

Overview button To return the display in the View to original setting before zoom 
and pan operations, click Overview.

The 2-D Slice box is moved up as the Up arrow key is 
pressed.
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Subset 3D View
The 3D View displays the entire subset. You can use this view to 
examine and clean data.
1. Select the 3D View command to open the 3D view window.

All controls for the 3D View are contained in the 3D View sub-
layer of the Subset Editor tab. 
1. Click the Expand ( + ) icon beside the HIPS Data layer and select the 

3D View sub-layer in the Subset Editor tab.

The properties for the 3D View are displayed in the Data Display 
area below.

3-D Subset Display
The Data Display Type selected will determine the soundings 
that will be shown in the 3-D View: 
1. Select the display type from the list.

• Points 
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• Spheres
• Cylinders
• Surface
• Surface Wireframe

The 3-D View is refreshed to show the soundings according to 
the selected display type. The options for each display type is 
explained in the following table. 

Controls
Rotation, illumination 
and exaggeration 
options

The compass (or control axes) rotates the view, the lighting 
control adjusts illumination, and the slider on the scale bar 
adjusts vertical exaggeration.

Display Type Definition Options

Surface The soundings are shown as a smooth 
surface.

Soundings are drawn to the 3-D View either by 
selecting the shoalest sounding in a user-
defined area (or bin), or by selecting all 
soundings.

1. Select the Shoal Bin Size to select the shoal-
est sounding in an area (bin), or select 
Use All Points to display every sounding.

2. If you selected the Shoal Bin Size option, type 
the size of the area for selecting the shoalest 
sounding.

3. Click Regenerate.

Surface Wireframe The soundings are shown as a 
Triangulated Irregular Network (TIN) 
that connects soundings.

Points Soundings are shown as unconnected 
points. 

3D Dynamic Skip option determines how many 
sounding profiles and beams are displayed. For 
example, the value 6 means that only every 6th 
profile and 6th beam are shown in the view.

1. Select a skip value by clicking the up or down 
arrow buttons, or directly typing a value in the 
3-D Dynamic Skip field.

2. Click Regenerate.

Spheres Soundings are shown as unconnected 
spheres.

Cylinders Soundings are shown as cylinders. If 
the soundings contain horizontal and 
vertical uncertainty values, then the 
cylinders are sized according to those 
values. For example, soundings on the 
outer edge of a swath have a larger 
radius than soundings on the inner 
edge because of the greater horizontal 
uncertainty. Soundings without TPU 
values are drawn to a set size.
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2. Select or clear the Compass, Lighting and Exaggeration check boxes to 
show or hide these controls in the 3D View.

Shading Darkens the image in the 3-D View.
3. Select the Shading check box.

Symbolize Critical 
Soundings

Display soundings with Outstanding, Critical and Designated 
flags.
4. Select the Symbolize Critical Soundings check box.

Overview Reset the View so the entire subset area is visible (default).
5. Click Overview.

Show subset outline Display an outline of the subset bounding box.
6. Select the Show Subset Outline option. When this option is checked, the 

outline is displayed in the 3D View.

Show 2D slice Display an outline of the 2D slice area.
7. Select the Show 2D slice option. When this option is checked, the 2D 

slice outline is displayed in the 3D View.

See “CHANGE VIEW PERSPECTIVE” ON PAGE 129 for illustration.
Allow rotation under 
data

This option rotates the 3D display by 180º to view soundings 
underneath the subset. When this option is not selected, the 
subset can only be rotated by 90º.
8. Select the Allow Rotation Under Data option to rotate the subset display 

by 180º.
Wireframe colours Select a colour to display 3-D and 2-D outline in the 3-D View.

9. Select a colour from the picker, or click Other and create a custom 
colour from the palette.

Compass

Lighting control

Slider 
on 
scale
bar
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Pan and zoom The pan, zoom and rotation functions are the same as in the 3-D 
View in the Swath Editor. See “PAN AND ZOOM” ON PAGE 166 for more 
information.

Measure Distance
You can use the Measure Distance tool in the 2-D and 3-D Views 
to evaluate data problems, such as timing offsets, heave 
problems, etc.
1. Select the Measure Distance command.

A ruler icon is displayed next to the cursor.
2. Press and hold the mouse button and drag the cursor along the 2-D 

View or 3-D View. To maintain a straight horizontal line, press and hold 
the <Shift> key while drawing the line. To maintain a straight vertical 
line, press and hold the <Ctrl> key while drawing the line.

As the cursor is dragged across the View, a line is drawn from 
the start point to the point where the mouse button is released. 
The distance between the two points is shown along the line.
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Close Subset Editor
1. Select the Subset Editor command.

2. If changes were made to the data, you are prompted to save them.

When data in Subset Editor is changed and saved, the 
ProcessedDepths and ObservedDepths files are updated to 
reflect the changes.
3. Click OK to save changes.

Subset Editor is closed and no longer visible in the HIPS 
interface.

M
en

u

Tools > Subset Editor

To
ol

Po
p-

up

Tools > Subset Editor



8
SVP Editor

SVP Editor helps you to edit existing SVP data, or to create new data.

In this chapter...
SVP EDITOR INTERFACE ............................................ 138
OPTIONS .................................................................. 141
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CREATE A NEW SVP FILE .......................................... 144
EDIT SVP DATA ....................................................... 146
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SVP Editor Interface
SVP Editor is a separate program that is launched from HIPS 
and SIPS. 
To open SVP Editor:
1. Select an SVP Editor command.

HIPS SVP Editor is displayed. 

The Profiles area lists profiles contained in the SVP file. The 
profiles include a latitude and longitude position for applying 
the Nearest in Distance option. Below the Profiles section is a table 
showing the depth/speed values for the selected profile. The left-
hand side of the editor contains a graphical representation of the 
depth/speed data for the selected profile.
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The Depth Scale slider determines the view for the depth/speed 
graphed area by setting a maximum depth value. You can 
change the vertical display of data by dragging the slider.
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Open an Existing File
1. Select the Open File command.

The Open dialog box is displayed. All SVP files are located, by 
default, in ..\Hips\Svp.
2. Select an SVP file so it is highlighted, or type the file path in the File 

Name text box.

3. Click OK.

A list of profiles is displayed. Data in the first profile is displayed 
in the Profile Data table and the speed/depth graphed area.
4. To navigate between profiles, click the time stamps in the Profiles list 

box.
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Options
You can select the colours used for the graphical display.
1. Select the Options command.

The Options dialog box is displayed.

Colour Options 2. Select a colour for the Display from the drop-down palette or create a 
custom colour from the Windows colour picker.

3. Click OK.

The display is refreshed to show the selected colours of 
background, selected points or lines.

Draw points Show or hide the depth/speed data points in the graphical 
display.
4. Select the Draw Points check box.

If the box is checked, the data points are visible in the graphical 
display.
5. Click Apply to apply and save changes to the current file.

6. Click OK.

Show/hide tool tips A tool tip is a label containing the depth/time position for a data 
point in the graphical display. The label becomes visible when 
the mouse cursor is moved in the graphical display.
7. Select the Tool Tips check box to show or hide the tool tips.

If the box is checked, the depth/time labels are visible.
8. Click Apply to apply and save changes to the current file.

9. Click OK.

Show Julian date Switch the date fields in the SVP editor between the regular 
calendar format and Julian calendar format.

M
en

u

Tools > Options
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10.Make sure the Julian Date box is checked if you want to select this 
feature.

11.Click Apply to apply and save changes to the current file.

12.Click OK to close the dialog box.
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SVP Files
Sound Velocity Profile files are in text format and can contain 
more than one section. The first line of the file specifies the 
version of the SVP file (line “a” in the example below).
The second line displays the path and name of the file (“b”).
The next line is a section heading for each profile, containing:

• the year and day (Julian date) that the profile was 
recorded (“c”)

• timestamp when the profile was recorded (“d”)
• the latitude and longitude of the profile location (“e”).

The SVP data is displayed in two columns, one containing the 
depth, and the other the speed value for that depth.
The following is an extract of the beginning of a sample SVP 
file:.
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Create a New SVP File 

To create a new SVP file:
1. Select the New File command. 

2. Add new SVP profiles (see “CREATE NEW PROFILE” ON PAGE 144.) 

3. Create new depth/speed values, as needed.

4. Select the Save As command.

5. Type a name for the SVP file in the file name box.

6. Click Save.

The file is saved the directory you selected.

Create New Profile
New SVP profiles can be created through SVP Editor.
1. Select the Add Profile command.

The Add SVP Profile dialog box is displayed.
 

2. Click the arrow buttons at the top of the calendar to select a month and 
year (all profiles must be time stamped).

3. Click a day button on the calendar to select a day for the file.

4. Enter the new hour/minute values (use the 24-hour clock) by clicking 
each section in the Time box and typing new values.

5. Enter latitude and longitude coordinates in the appropriate boxes, if 
needed.

6. Click Add to apply settings.

The new file information is displayed in the Profiles box.
If you are enter new speed/depth data, you must enter this data 
in pairs. There are two options for entering data:

M
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File > New
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• separate the depth/speed data with a space: 15 1200
• separate the data with a comma: 15, 1200

Enter new depth/speed data
7. Click a profile to display the data in the SVP editor.

8. Type new depth and speed values in the text box beside the Add 
button.

9. Click Add.

10.Repeat Steps 1 through 3 until all necessary values are entered.
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Edit SVP Data
You can use the SVP Editor to modify existing speed/depth 
values, append new data to an existing file, delete data or delete 
a complete profile. 

Change depth/speed 
values 

Individual values in the depth/speed table can be changed.
1. Position the cursor over any Depth or Speed cell in the table.

2. Click inside the cell.

3. Type a new value.

4. Click outside the cell.

The table is changed to reflect the new data.
Edit geographic 
coordinates

Enter new latitude and longitude positions for SVP data. This 
information is important if you want to use the Nearest in Distance 
option for sound velocity correction (see “SOUND VELOCITY PROCESSING” 
ON PAGE 241).
1. Click a time stamp beside a profile.

2. Select the Edit Position command.

The Edit Position dialog box is displayed.

3. Click the latitude coordinates and type new ones.

4. Click the longitude coordinates and type new ones.

5. Click OK.

The new geographic coordinates are displayed in the Latitude and 
Longitude sections of the Profiles area.

Delete speed/depth 
data

1. Press and hold the mouse button, while dragging the cursor over the 
data points in the graphical display, or click a row number in the table.

The selected data is highlighted.
2. Select the Delete command.

The Speed/Depth data points are removed from the graphical 
display and the values are no longer displayed in the table.

M
en
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Edit > Edit Position
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Edit > Delete
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Remove Profiles Remove a currently open profile from the SVP file.
1. Select a profile by clicking the time stamp in the Profiles list box.

The depth/speed values are displayed in the editor.
2. Select the Remove Profile command.

The profile is removed.

Exit SVP editor
Close the SVP Editor.
1. Select the Exit command.

2. If you have not saved any changes you are prompted to do so.

The SVP Editor is closed.

M
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u Edit > Remove 
Profile
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9
Swath Editor

Swath Editor provides data-cleaning tools for multibeam data, multi-
transducer data and Lidar data.

You can also use Swath Editor to designate shoalest soundings.

In this chapter...
SWATH EDITOR INTERFACE.......................................... 150 
VIEWING DATA .......................................................... 152
SWATH EDITOR DISPLAY OPTIONS................................ 155
SWATH EDITOR CONTROLS.......................................... 150
EXAMINING SWATH DATA ............................................ 159 
3D VIEW CONTROLS .................................................. 162
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Swath Editor Interface
A track line must be selected before Swath Editor editor can be 
opened.
1. Select the Open Swath Editor command.

Swath Editor opens and displays data in six different view 
windows (see “VIEWING DATA” ON PAGE 152). 
The directory path and file name of the selected track line is 
displayed on the title bar. The image below shows the default 
layout for the Swath Editor windows.

The main elements of the Swath Editor are:
• the Swath Editor tab in the Control window 
• Swath Editor data view windows
• Swath Editor toolbar 

Swath Editor Controls
The Swath Editor tab has three tabbed pages: 
• The General tab controls the data display in the the Swath 

Editor windows (see “SWATH EDITOR DISPLAY OPTIONS” ON PAGE 155).

M
en

u Tools > Swath Editor  
> Open

To
ol
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• The 3D tab contains the Swath 3D view controls (see “3D VIEW 
CONTROLS” ON PAGE 162). 

• The WCI tab controls display options for the water column 
imagery windows(see “WCI CONTROLS” ON PAGE 459).

Swath Editor Toolbar
You can display or hide these views is controlled from the Swath 
Editor toolbar.

This is a floating toolbar that is automatically displayed when 
the editor is opened. The toolbar can be docked or floated over 
any area of the interface. Its appearance is controlled from the 
Toolbar dialog box (see “DISPLAY TOOLBARS” ON PAGE 33).

If the dataset also contains side scan data, you can open 
Side Scan Editor while Swath Editor is open.

Plan View

Rear View

Side View

Profile 

Amplitude
3D View Port&Starboard Beams 

Port Starboard 
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Viewing Data
Swath Editor consists of six view windows. These windows open 
by default when the Swath Editor is opened:
• Plan View
• Rear View
• Side View
• Profile View
• Amplitude View
• 3D View
•
As well, water column imagery can be viewed in Across-track 
and Along-track windows. These windows will display 
automatically if water column data is available when Swath 
Editor is opened. (See “WCI IN SWATH EDITOR” ON PAGE 455

View windows can be displayed, hidden, resized or repositioned 
anywhere on the interface. The layout of the view windows is 
remembered by the application when you exit the editor.

deTrend
If you are viewing data that lies up or down a slope you can use 
the deTrend command to “flatten” the view so that you can more 
easily see anomalies in the data. This is especially useful in the 
Rear and Side Views. 
The deTrend function works by removing the average slope in 
the alongtrack direction.
To apply the deTrend command, 
1. Select a track line.

2. Select the deTrend command

The windows which contain data which has been flattened this 
way are now labelled “ deTrend”. 

Plan View
The Plan View presents an overhead view of the swath profiles 
and beams. All profiles are spaced equally in the along-track 
direction. Across-track beam spacing is to correct scale. Each 
beam is represented by a square.
1. Select the Plan View command.

M
en

u Tools > Swath Editor 
> deTrend
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The number of swath profiles displayed in the Plan View is 
determined by three factors:
• height of the view
• point size of the beams
• distance (in points) between swath profiles (see “DATA DISPLAY IN 

VIEWS” ON PAGE 154)

To help distinguish soundings by colour you can apply a number 
of options. Using the options on the General page of the Swath 
Editor tab in the Control window, you can:

• colour by depth interval (see “COLOUR BY DEPTH” ON PAGE 158)
• sun illumination (see “LIGHT CONTROL” ON PAGE 164).

Using using the Display options in the Tools > Options dialog 
box, you can 

• colour soundings by their location in the swath (port or 
starboard beams) or 

• colour soundings by the detection method used by the 
sonar (not supported by all sonars) 

Rear View
The Rear View presents the survey as seen from behind the 
vessel. Each line represents one swath. 
1. Select the Rear View command.

Side View
The Side View presents the survey as seen from the side of the 
vessel with the vessel travelling from left to right. Each line 
represents soundings from the same beam.
1. Select the Side View command.

You can change the display (see “DATA DISPLAY IN VIEWS” ON PAGE 154). 
and depth label settings for this view (see “VIEW SOUNDINGS AS POINTS 
OR LINES” ON PAGE 157).

Profile View
The Profile View displays a single swath.
1. Select the Profile View command.

M
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u Tools >Swath Editor 
>Plan

To
ol
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u Tools > Swath Editor 
> Rear

To
ol

M
en

u Tools > Swath Editor 
> Side
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The time stamp and profile number of the swath are shown in 
the status bar.

Amplitude View
The Amplitude View displays the beam-averaged amplitude 
data that is recorded with the swath bathymetry data.
1. Select the Amplitude View command.

Beam-averaged amplitude data are intensity values for each 
sounding depth created by a multibeam sonar system.

3D View
The three-dimensional (3D) View shows all soundings currently 
visible in the Plan View in three-dimensional format. The data 
in this window can be rotated and moved around (see “COMPASS” ON 
PAGE 163).
1. Select the 3D View command.

Data Display in Views
You can show or hide the display of data in the Rear, Side and 
Profile Views: 
• show or hide port beams
• show or hide starboard beams
• show both port and starboard beams (default setting)
1. Choose the Port or Starboard Beams command.

The display is refreshed to show only the Port or Starboard data. 
2. To view both starboard and port beam data, select the Port and 

Starboard Beams command.

Both Port and Starboard beams are displayed in the Rear, Side 
and Profile Views.
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u Tools > Swath Editor 
> Profile
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Swath Editor Display Options
Display of data in Swath Editor can be manipulated through the 
controls in the General, 3D View and Water Column tabs in the 
Control window.
“GENERAL TAB” ON PAGE 155

“3D VIEW CONTROLS” ON PAGE 162

“WCI CONTROLS” ON PAGE 459

General tab
The display options for the Plan, Rear, Side,  Profile and 
Amplitude View windows are controlled through the General 
tab. 

The following sections describe the options in this tab. 
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Vertical Exaggeration
The vertical exaggeration is the ratio of the vertical scale versus 
the horizontal scale used in the Rear and Side Views.
The vertical exaggeration can be determined automatically by 
including all visible depths or it can be manually set.
When Auto mode is on, the Include Rejected option controls whether 
or not the rejected data is used to determine the minimum and 
maximum sounding depth in the Rear and Side Views. 
1. Deselect the Auto mode by clearing the check box.

2. Click the up or down arrow buttons beside the Vertical Exaggeration 
box to set the vertical exaggeration.

You can set the vertical and horizontal scale of the view to 
control the amount of rejected data in the view 
3. Select the Include Rejected option to resize the display in the view to 

include rejected data.

This deTrend option is used when the general slopes of the sea 
floor topography makes it difficult to see individual depth spikes. 
DeTrend removes the general slope of the sea floor from the Rear 
and Side views and redraws the swath and beam profiles 
making it easier to locate depth spikes.
4. Select the deTrend check box to view data. Select the command by 

selecting from Tools > Swath Editor > deTrend.

Specified Min-Max
Use a constant scale as an alternative to vertical exaggeration 
by setting a minimum and maximum range for displaying data.
1. Select the Specified Min-Max check box to implement this option.

2. Type the minimum and maximum ranges for the scale.

The views are automatically refreshed to show data according to 
the scale.

Middle mouse button
Use the Middle Button Select option to select an individual 
swath or beam profile and see its location in the Display window.
See “SELECT SWATH AND BEAM” ON PAGE 160 for examples on using this 
tool.
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View soundings as points or lines
By default, soundings in the Side, Rear, and Profile views are 
connected by lines. Sometimes they can be more clearly 
distinguished if displayed as points.
To change lines to points:
1. Select the General page of the Swath Editor tab in the Control window.

2. Select the View as Points check box.

3. Click the up or down buttons beside the Point Size box to set a size 
value between one and five pixels.

Changing the Point Size will also change the size of the points in 
the Plan view.

Profile spacing
The Profile spacing control adjusts the displayed distance between 
the beams in the Rear, Side, Plan and 3D views. You can adjust 
the spacing between beams from 1 pixel to 10 pixels apart.
The Number of Profiles box displays the maximum number of 
profiles visible in the Plan view at its current size and profile 
spacing. This value is incremented up or down as you change the 
profile spacing.
The difference between minimum and maximum spacing of the 
same data within the same size window is illustrated below. 

Soundings connected by lines

Soundings viewed as points, size 2 pixels
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Colour By Depth
Display soundings as colour coded by depth interval.
1. Select the General page of the Swath Editor tab in the Control window.

2. Select the Colour by Depth box so it is checked.

3. Click the up or down buttons beside the Depth Interval box to select a 
depth interval for the colour band. 

The soundings are now displayed by depth level. 

Profile spacing set to 1 pixel
256 profiles visible in this view 

Profile spacing set to 10 pixels
38 profiles visible
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Examining Swath Data
The scroll bar in the Plan View represents the time period of the 
entire line. You can use the slider to move alone the trackline or 
use the scroll arrows for more precision. 
Each click on an arrow button moves the screen forward or 
backward one swath. Clicking the grey area of the scroll bar 
moves the screen forward or backward for a set of swaths. As 
you move along the track line, all the views refresh to display 
the same data as in the Plan View window.

As you move up or down the track line, all the views refresh to 
display the data from the swaths that are visible in the Plan 
view.
The geographic location of the swaths currently in view is shown 
by the sounding coverage outline in the Display window (see 
“SWATH COVERAGE OUTLINE” ON PAGE 161). 
As an alternative, use the following methods to scroll through a 
track line:
• Press the space bar to move up the track line.
• Use the mouse wheel (if available) to move up or down the 

track line.
• Press <Ctrl + spacebar> to move down the track line.
• Use the mouse wheel (if available) to move up or down a track 

line.
• Press the <Home> or <End> buttons to move to the start or 

end of the track line.

Click here to 
move forward 
or back one 
swath

Move slider 
to view any 
location on 
the line

Click here to 
move forward 
or back a set of 
swaths 
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Select Swath and Beam
The Middle Button Select option lets you select an individual 
swath or beam profile and see its location in the Display window.
By moving the cursor in the Plan, Rear, 3-D or Side View while 
holding down the middle mouse button, individual swaths and 
beams will be highlighted in the Display (see example below).

To view both beam and swath profiles
1. Select the Beam and Swath check box in the Middle Mouse Select section 

of the General tab in the Control window.

2. Place the cursor in either the Plan View, Rear View or Side View and 
click the middle mouse button.

The selected swath is highlighted.The other views are updated 
to reflect the same beam and swath location. The positions of the 
swaths and beams are also displayed in the sounding coverage 
outline.
If the Attitude Editor is open, you can view the sounding’s 
position in relation to attitude data by the yellow line in any of 
the sensor windows (see “ATTITUDE EDITOR” ON PAGE 185).

MIddle mouse 
click here…

shows swath and 
beam in Display
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Swath Coverage Outline
)The swath coverage outline is a marker in the Display window 
that shows the location of data currently visible in Swath Editor 
(as in the example below. The display of the outline is controlled 
from the Options dialog box (see “SENSOR EDITORS” ON PAGE 90).

Automatic Recentre The automatic recentre option ensures that when the coverage 
outline reaches the edge of the Display window (when scanning 
along the track line), the display redraws with the coverage 
outline in the centre. This option is available in the General 
Options dialog box. (see “GENERAL” ON PAGE 77).

Changing Track Lines
After examining a track line, you may want examine another 
line. 
There are four options for navigating between track lines in 
Swath Editor:
• Select the Next Line command

• Select the Previous Line command
• Click a line in the Display window so that the line is opened 

in Swath Editor at that location
• Select a track line file name Project data tree in the Control 

window. 
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Select > Next Line

To
ol

M
en

u Select > Previous 
Line

To
ol



162 CARIS HIPS and SIPS Editors

Swath Editor: 3D View Controls

3D View Controls 
Swath data can be displayed in 3D format. The 3D feature 
provides greater flexibility for examining and cleaning data.
1. Select the 3D View command.

The 3D view window is displayed in Swath Editor. This 3D 
display is manipulated by three controls on the 3D View tab of 
the Swath Editor tab in the Control window(displayed below).
 

These controls are:
• the compass 
• the vertical exaggeration slider
• the light control. 
The line thickness of these controls can be altered by changing 
the Control line weight value in the 3-D View tab.

M
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u Tools > Swath Editor 
> 3D View

To
ol
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Compass
In the 3D View window, rotation along the X-Y-Z axis is handled 
by moving the arrow heads at the ends of the compass. 

1. To rotate the image along the Z-axis, position the cursor on the middle 
arrow head, press and hold the mouse button, and drag the cursor so 
that the image is rotated. The compass can be rotated 90º.

2. To rotate the image along the X-Y axis, position the cursor on any of 
the other arrow heads, press the mouse button and drag the arrow 
head in a left-right or up-down direction. The compass can be rotated 
360º.

3. Alternatively, the image can be rotated in the horizontal plane by 
grabbing the Z-arrow, then pressing the left-mouse button and moving 
the cursor up and down. Rotation around the Z-axis can be performed 
by pressing the <Shift> key and moving the cursor left and right in 
these windows. 

The image is rotated in the same direction as the arrow heads.
4. To return the image to its original position, click Overview in the 

3D View tab.

The image is restored to its original position. 

Vertical Exaggeration Slider 
By changing the vertical exaggeration, you can display seabed 
features more clearly.
Vertical exaggeration is controlled by the scale slider in the 3D 
View. The slider can be displayed or hidden by selecting (or 
clearing) the Show Vertical Exaggeration check box in the 3D Controls 
tab.

Z-axis rotation arrow
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You can also change the vertical exaggeration using a dialog box.
3. Double-click the ball in the vertical exaggeration slider.

The Vertical Exaggeration dialog box is displayed.
4. Type a value in the Vertical Exaggeration field and click OK.

The display is refreshed to show the image according to the 
selected exaggeration scale. The scale value is displayed below 
the slider.

Light Control
The lighting control handles shading effects by controlling the 
position and angle of the light.
The elevation value (on the bottom right of the compass) varies 
from 90º to 0º starting from the middle of sundial. The azimuth 
value (on the bottom left of the compass) varies from 0º to 360º in 
a clockwise direction. The lighting control can be displayed or 
hidden by selecting (or clearing) the Show Light Control check box in 
the 3D View tab.

1. To change vertical exaggeration, position 
the cursor over the green ball on the 
vertical exaggeration scale.

2. Press and hold the mouse button, and 
move the ball up or down the scale.
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You can also change the shading effect using a dialog box.
1. Double-click the ball in the lighting control.

The Set Sun Position dialog box is displayed.
2. Type new values in the Sun Elevation and Sun Azimuth fields and click 

OK.

The image is refreshed to the new lighting angle.

and move the lighting control ball 

ElevationAzimuth

1. Position the cursor over the ball 
in the lighting control.

2. Press and hold the mouse button, 

As the ball is moved, the azimuth 

with the mouse.

and elevation values change.
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Pan and Zoom
There are three pan options for the 3D View:
• To pan along the X-Y axis: place the cursor in the 3D View, 

press the middle mouse button and drag the display to a new 
location.

• To pan along the Z-axis: place the cursor in the 3D View, 
press and hold the <Shift> key and middle mouse button and 
move the cursor in the window.

• To centre the 3D View window on a selected point: position 
the cursor over the point and click the middle mouse button.

There are three zoom options:
• Press and hold the <Ctrl> key and right-mouse button and 

drag the cursor up in the display to zoom into display.
• Press and hold the <Ctrl> key and right-mouse button and 

drag the cursor down in the display to out of display
• Rotate the mouse wheel in a counter-clockwise direction to 

zoom into the display, or rotate the mouse wheel in clockwise 
direction to zoom out of the display.

Close Swath Editor
To close Swath Editor 

1. Click the Swath Editor tool button again. 

All Swath Editor view windows are closed and you are prompted 
to save any changes.
Click OK to save changes.
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Use Tide Editor to create or edit tide files. Tide data is used to generate 
final depths relative to the tide datum by subtracting the tide from the 
sounding depth.

In this chapter...
OPEN TIDE EDITOR .................................................... 168
EDITING TIDE DATA.................................................... 171
CREATE A NEW TIDE FILE ........................................... 173
DISPLAY OPTIONS ...................................................... 174
EXIT TIDE EDITOR...................................................... 170
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Open Tide Editor
Tide Editor presents tide file information in both graphical and 
tabular formats. You can use the editor to edit an existing file or 
to create a new tide file to apply to survey lines before the Merge 
process.
Tide files are located by default in …\Hips\version\Tide and 
have a .tid file extension. 
To open Tide Editor: 
1. Select the Tide Editor command.

The Tide Editor interface is displayed.
 

M
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Edit > Tide
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Graphic display

Data display
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To open tide data in the editor:
2. Select an Open command to display the Open dialog box. 

3. Select a tide file and click Open, or type the file name and path in the 
field. 

The selected tide file is displayed in the editor.The top part of 
the editor shows a tide versus time graph of the data. Tide-level 
values are represented on the vertical axis. Time is represented 
on the horizontal axis. These scales can be adjusted using slider 
controls. 
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File > Open
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Tool tip

Data points
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The tide data is displayed in a table below the graphical display.
Adjust tide scale To control the vertical scale of the graphical display: 

• Move the Tide Scale slide bar to select a range for the height of 
the vertical tide axis.

Adjust time interval Change the horizontal scale by adjusting the Time Interval 
setting. 
• The day option lets you view data by 24-hour increments.
• The hour/minute option lets you view data in increments of 

less than 24 hours.
1. Click the Day arrow buttons to select the range of days for displaying 

data.

2. If the Day value is set to zero then move the slide bar to select the 
minute/hour range for the display of data.

The display of tide data is adjusted for the new time interval 
along the horizontal axis.

Save a tide file Save changes to an existing tide file.
1. Select the Save command.

The file is saved with the changes.
For display options, see “DISPLAY OPTIONS” ON PAGE 174.

Exit Tide Editor
Close Tide Editor.
1. Select the Exit command.

You are prompted to save any unsaved changes.
2. Click Yes to save the changed file.

Tide Editor is closed. 

M
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u

File > Exit
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Editing Tide Data
Edit table data Edit data in an existing tide file.

1. Select a Date/Time/Tide cell in the tide table.

The cursor is displayed in the cell.
2. Remove the existing data and type a new entry.

The graphical display refreshes to show the new data.
Delete a tide entry 1. Press and hold the mouse button while dragging the cursor over data in 

the graph, or click the appropriate number cell in the tide table.

The data is highlighted.
2. Select the Delete command.

The tide data is removed from the graphed line and the table.

Search time gaps Tide gauges, recording tidal height observations, may be subject 
to occasional outages resulting in gaps in the tidal time series. 
The time gaps option lets you search for these gaps. You can 
enter new data, if needed.
1. Select the Options command.

The Options dialog box is displayed.
2. Select the General tab if it is not already displayed.

3. Enter a value (in minutes) in the Time Gaps box.

4. Click OK.

5. Select the Next Time Gap command.

When the interval (in minutes) between adjacent data points is 
the same as, or greater than, the Time Gaps value, the adjacent 
data points are highlighted.
6. Repeat the process, if necessary, by selecting the Next Time Gap 

command for each tide data point on the graphed line.

You can enter new data between two values.
Enter new data Enter data for a new or existing tide file.

1. Select the Add Tide command.

The Add Tide dialog box is displayed.
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Tide Editor: Editing Tide Data

2. Change the date (if necessary) by clicking the arrow buttons at the top 
of the calendar until you have selected the desired month and year.

3. Click the appropriate day button on the calendar.

The selected date (year and day) is displayed below the calendar.
The default time is the time of the currently selected tide record.
4. Click any of the three sections (00:00:00) in the Time box so they are 

highlighted and type the desired time (use the 24-hour clock).

The Input Interval option lets you quickly enter a series of tide 
values at a regular time interval, using the <Enter> key. You do 
not need the mouse to move the cursor between fields.
5. If you want to regularly increment the times for tide data, click the Input 

Interval check box.

6. Enter the minutes that the time value is to be incremented.

7. Enter a tide value.

8. Click OK.

The new tide data is displayed in the editor. If you selected the 
Input Interval option, the time is incremented by the value set in 
the Input Interval box.
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Tide Editor: Create a New Tide File

Create a New Tide File 
You can create new tide file. 
1. Select the New command.

Any tide file that is currently open in the editor is closed.
2. Select the Add Tide command and type a new tide entry (see “ENTER 

NEW DATA” ON PAGE 171).

The data is displayed in graph format in the editor.
3.  Repeat until all values are entered.

4. When ready, select the Save or Save As command.

The Save As dialog box is displayed.
5. Type a name for the file and click OK.
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Tide Editor: Display Options

Display Options
You can adjust the display of graphical data: colours, display of 
data points and tools tips.
1. Select the Options command.

The Options dialog box is displayed.

Colours Set colours for display elements. Select a colour from the drop-
down colour palettes, or create a custom colour from the 
Windows colour picker.
Click OK to to show the new colours.

Show/hide tide points The editor displays the tide data as a line graph. You can display 
the points making up this line, or turn them off . This option is 
set on by default. 
To turn off the display of tide points:
2. De-select the Draw Points check box.

Show/Hide tool tips A tool tip is a label that displays a specific tide level on the 
graph, when the cursor is positioned over it. You can turn these 
label on or off. 
3. Select the Tool Tips check box. If this option is checked then it is 

enabled.

Set date display The date in tide file table is displayed by default in regular 
calendar format. To display in Julian Day format: 
4. Click the Julian Date box. (If the box is checked, this option is selected.)
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Vessel Editor

Use Vessel Editor to create HIPS vessel files, and to edit sensor offsets 
and uncertainty estimates in those files.

In this chapter...
VESSEL EDITOR INTERFACE ......................................... 176
HIPS VESSEL FILE (HVF) ......................................... 178
3D DISPLAY CONTROLS.............................................. 180
COLOUR OPTIONS FOR SENSOR DISPLAY ......................... 182
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Vessel Editor: Vessel Editor Interface

Vessel Editor Interface

Open Vessel Editor
Vessel Editor is launched from the HIPS and SIPS interface.
1. Select the Vessel Editor command from the Edit menu or from the 

Tools toolbar.

Vessel Editor is displayed. 
The image below shows an example of Vessel Editor displaying a 
vessel file and a vessel outline.
 

Vessel Editor displays a 3D wire-frame diagram of the vessel. 
The display can be manipulated in three dimensions using the 
3D Display controls. See “3D DISPLAY CONTROLS” ON PAGE 180. The 
location of a sensor is represented by a coloured dot or line. See 
“COLOUR OPTIONS FOR SENSOR DISPLAY” ON PAGE 182 to change the colours 
of the sensor display.

Reference point

Time stampsSensor
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Vessel Editor: Vessel Editor Interface

In the upper right-hand corner of the 3D display is a drop-down 
list containing all the unique time stamps in the vessel file. You 
can select a time stamp and view the outline configuration at 
that single point in time.
Sensor data is displayed in a table below the 3D vessel outline. 
This data can be edited.
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Vessel Editor: HIPS Vessel File (HVF)

HIPS Vessel File (HVF)
The HIPS and SIPS Vessel wizard is used to set the parameters 
needed to create a new vessel file. The wizard takes you through 
the steps to enter vessel information and sensor configuration 
information based on the type of survey data. 
The Vessel Wizard is launched from the New command. Step 1 
of the Wizard asks for vessel information, such as the name of 
the vessel and survey date. The number of dialog boxes that 
follow Step 1 depends on the type of sonar selected in the step 2 
dialog box.
To create an HVF using the Vessel Wizard see “CREATE A NEW HVF” 
ON PAGE 27.
Once the vessel file is created you can enter the sensor position 
data using a 3D outline for the vessel. See “CREATE VESSEL SHAPE 
OUTLINE” ON PAGE 35.
Then you can enter or edit sensor information for the active 
sensors as determined by the sensor parameters selected when 
the vessel file was created. You can also designated other 
sensors as active. See “SENSOR CONFIGURATION” ON PAGE 38

Open and Close Files
To open a saved file in Vessel Editor: 
1. Select the Open command from the file menu.

The Open File dialog box is displayed.
2. Select the file from the list and click OK.

The file opens in Vessel Editor with the vessel’s outline 
displayed in the editor, and a list of active sensors displayed in 
the Sensors list box.

To close an existing file:
1. Select the Close command from the File menu.

You are prompted to save changes made in Vessel Editor.
2. Select a Save command.

M
en

u

File > New

To
ol

Vessel Configuration Files that were created in previous 
versions of HIPS and SIPS can be opened and edited in 
Vessel Editor. The files are automatically re-saved as 
HIPS Vessel Files. 
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Vessel Editor: HIPS Vessel File (HVF)

3. Click OK.

To create a text file listing the parameters entered in Vessel 
Editor: 
1. Open the HVF in the Vessel Editor.

2. Select the Vessel Report command. from the Tools menu.

The Save As dialog box is displayed. The default directory is 
Hips\version number\HDCS_Data\VesselConfig.

Exit the Vessel Editor
Close Vessel Editor and all files.
1. Select Exit from the File menu. 
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Vessel Editor: 3D Display Controls

3D Display Controls
The outline displayed in the editor can be rotated, zoomed and 
panned using the compass (control axes), keyboard, and mouse.

Compass Rotation along the X-Y-Z axis is handled by moving the arrow 
heads at the ends of the compass.

1. To rotate the image along the Z-axis, click the middle arrow head and 
drag the cursor upward so that the image is rotated. The compass can 
be rotated 90º.

2. To rotate the image along the X-Y axis, click any of the other arrow 
heads and drag the arrow head in a left-right or up-down direction. The 
compass can be rotated 360º.

3. Alternatively, the image can be rotated in the horizontal plane by 
grabbing the Z-arrow, then pressing the <Ctrl> key and the left-mouse 
button and moving the cursor up and down in the view. Rotation around 
the Z-axis can be performed by pressing the <Shift> key and moving 
the cursor left and right in these windows.

Pan There are three pan options:
• To pan along the X-Y axis: place the cursor in the 3-D area, 

press the middle mouse button and drag the display to a new 
location.

• To pan along the Z-axis: place the cursor in the 3-D area, 
press and hold both the <Shift> key and middle mouse button 
and move the cursor in the window.

• To centre the 3-D Display window on a selected point: 
position the cursor over the point and click the middle mouse 
button.

Zoom The zoom option is similar to pan.
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Vessel Editor: 3D Display Controls

1. Press and hold both the <Ctrl> key and right-mouse button while 
dragging the mouse up or down to zoom in or zoom out.

Modify Toolbar
The Vessel Editor toolbar is visible below the menu bar when the 
application is opened. The toolbar can be undocked from this 
location and positioned within the interface, or on your desktop. 
You can also hide the default toolbar by removing the check 
mark next to Toolbar on the View menu.
To make the toolbar visible again, 
1. Select Toolbar from the View menu so it is checked.

Move toolbars Toolbars can be moved to any location on the desktop:
1. Position the cursor over any area of the toolbar not covered by a 

button, 

2. Press and hold the mouse button while dragging the toolbar to a new 
location.

3. Release the mouse button to position the toolbar.

Toolbars will automatically dock when they are close to certain 
areas of the interface. To stop the toolbar from automatically 
docking, hold down the <Ctrl> key while moving the toolbar.

Modify appearance You can alter the appearance and size of toolbar buttons.
1. Select the Customize command.

The Customize dialog box is displayed.
2. Select any of the following three options by checking a box.

• Tool Tips: Display the name of a command button when the cursor is 
placed over it.

• Cool Look: Remove the border outline from the buttons.
• Large Buttons: Display buttons with 32 x 32 pixel icons instead of 

16 x 16 pixel icons.

3. Click OK.
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Vessel Editor: Colour options for sensor display

Colour options for sensor display
The locations of sensors and other equipment in the Vessel 
Shape 3D display are shown by colour markers. (You can set 
other colours for sensor markers.)
1. Select the Options command.

The Options dialog box is displayed.
2. Select the Options - Colours tab.

3. Select a colour from the pull-down palette, or create a custom colour 
from the standard Windows colour picker.

4. Click OK to activate the changes and close the Options dialog.
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